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Prerequisites and assumptions
This guide assumes that:

Integra Codebase 4.2 SP1 has been installed and configured. To install, see the
Integra Codebase 4.2 SP1 Installation Guide. To configure, see the Integra
Codebase 4.2 SP1 Administration Guide.

Integra Codebase users are also business application users with sysadmin,
superuser, or user privileges

Integra Codebase users are familiar with the use of the business application
software



Intended audience
DBAs, project managers and developers who must:

e Plan and manage Codebase projects
e Train Codebase users

o Use Codebase to develop customizations and/or extensions to business
applications, and other programmatic content (e.g., files and database objects)



Documents about Integra Codebase 4.2 SP1
Release Notes provides a quick overview of the new features offered in Integra
Codebase 4.2 SP1.

Implementation Overview describes Integra Codebase 4.2 SP1's installation
requirements, prerequisites, and other pre-installation considerations. It also discusses
business decisions that can affect installation, configuration and use.

Installation Guide gives step-by-step instructions for installing Integra Codebase 4.2
SP1.

Administration Guide explains how to configure and administer Integra Codebase 4.2
SP1.

User Guide shows how to use Integra Codebase 4.2 SP1 once it has been installed and
configured.



Terminology
Using Integra Codebase

Codebase
Home schema

Codebase
Server

Environment

Module

Project

Database schema that stores all Codebase configuration data, and
the information needed for comparing and versioning your files
and database objects. Codebase can share this database with other
applications.

The schema resides in an Oracle database. The database, in turn,
can reside on any server (including the Codebase Server).
Codebase users and the Codebase Server access the schema using
SQL*Net.

Runs the Codebase application, including its automated processes
(Automated Versioning, Automated Publishing, Automated
Change Finder and Automated Generation).

Database instance monitored by Integra Codebase, and a set of
files associated with that instance.

Example: an Oracle E-Business Suite database instance, and the
collection of programmatic files used by the Suite.

A single piece of programmatic content, such as a file or a
database object (including Oracle E-Business Suite forms, reports,
menus, libraries, and PL/SQL code).

Collection of Environments that are part of a code promotion
hierarchy (e.g., Development, Test, and Production), and a set of
user permissions and other configuration information. Projects are
usually used to represent logical units of work as well as groups of
Environments. The Project Administrator must create projects
before anyone can use Codebase.



Contact us

If you have questions about the use of Integra Codebase 4.2 SP1 after reading this
guide, please contact Oracle Support at integra.support@logicalapps.com.

If you would like information about new applications, functionality, or fixes, please
contact your Account Manager or email Oracle Sales at sales@logicalapps.com.
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If you're using Integra Codebase for the first time

What is Integra Codebase?

Integra Codebase provides change tracking, impact analysis, and versioning of both
files and database objects, including Oracle E-Business Suite forms, reports, menus,
libraries, and PL/SQL code. A component of the Oracle Integra Suite, Codebase
provides superior tracking and reporting of changes - planned as well as executed.

Integra Codebase increases the effectiveness of development efforts while minimizing
the challenges that cause project overruns and production downtime. Whether
applying a patch, upgrading to a new release, or extending Oracle to meet specific
business requirements, Codebase dramatically reduces the time and resources
required to identify changes, dependencies, and impact on your environment.

Integra Codebase’s unique functionality provides the industry’s deepest level of
impact analysis. Using binary code comparison and dependency recognition,
Codebase delivers robust documentation and analysis of your business applications
programmatic content.

Integra Codebase has eight major components:

Maintain Interactive version reporting, comparison, and control, (including
Versmns‘:g. check-out/in, labeling, and restore), for all programmatic content
) types, including files, forms, reports, menus, libraries, and PL/SQL.

Automated Automatically versions files and database objects whenever they

Versioningg(g). change. Populates Maintain Versions (p. 43).

Automated Migration process that promotes files, creates executables, and

Generatio?égi installs database objects in an Environment.

Change Finder Interactive component that finds differences in files, database
(p. 69) objects and database schemas.

Automated Monitors files and schemas for changes.
Change Finder
(p.116)



Publish (p. 92)

Automated
Publishing (p.
124)

Object Finder
(p. 80)
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Creates documentation of programmatic content on demand.

Automatically creates documentation of programmatic content.

Interactive component that lets you search for procedures, files,
database object dependencies, subclassed forms, or attached
libraries.

The following diagram depicts a typical installation managing an Oracle E-Business
Suite environment:

Codebase Home

Client Browser| [+ check-in/out

=

Forms Web Server v

webutil

ts_admin

Ul

v

Reports

| scheduler |

AV AG CF OF AP

§ ¥ I SCP

Codebase Repository Remote
modu_le dir_ectories Ib?::igﬁg: Apps _
version zip files Directories

APPS

How to use Integra Codebase

To get started, create one or more Projects using the Maintain Projects window (p. 33).

Once you've done that, you have several options:
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For complete version control and change reporting, schedule Automated
Versioning (p. 93). Once it has run, use the Maintain Versions (p. 43) to monitor
and compare versions, and to check out/in content (aka "modules").

If your organization uses another content versioning system, use Change
Finder (p. 69) and/or Automated Change Finder (p. 116) to get detailed reports
of changes.

To promote modules from one Environment to another, schedule Automated
Versioning (p. 93). Once it has run, set the modules' destination in the Maintain
Versions window's (p. 43) Promote to field. Then schedule Automated
Generation (p. 103) to perform the promotion. For more information, see
Promotion (p. 58).

To create reports that document your modules, use Publishing (p. 92) or
Automated Publishing (p. 124).

To search modules, use the Object Finder (p. 80).
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If you've used Integra Codebase before

Integra Codebase 4.2 offers many advantages over previous releases. It uses a new
Java architecture that provides robust support for both Unix/Linux and Microsoft
Windows Environments. It also has an improved user interface that's more reliable and

easier to use.

The following chart summarizes the most significant differences between Codebase

3.9,4.1,and 4.2:

Operating
System

Usability

Performance

Environments
and Objects

Codebase 4.2

Unix/Linux and Microsoft
Windows

Streamlined and simplified user
interface

Standard J2EE processes replace
Oracle Forms background
processes, providing increased
stability and reliability

Improved performance for all
automated processes

Generation performance based
on number of files generated

SSH and SCP allow management
of unmounted directories;
directory mounts are still
supported

Defining a promotion hierarchy
is as simple as entering a list of
Environments (p. 37)

Assets can be promoted to any
environment in the hierarchy

Codebase 3.9 and 4.1

Microsoft Windows only

Performance related to
number of files monitored

Managed file directories must
be mounted on Codebase
server

A two-dimensional array of
"Environments" and "Stages"
must be configured

Assets must be promoted to
each environment in the
hierarchy, in the hierarchical
order



Generation

Creating
documentation

Same file name can appear in
any number of directories; same
database object name can
appear in any number of
schemas

Support for versioning and
generating more database
object types

Generates only files marked for
promotion

Improved logic to determine
whether generation succeeded
for User Defined Extensions
(UDEs)

Expanded set of UDE
substitution variables

Support for more object types

Command logs available within
generation logs

New Publishing component (p.
92) provides documentation on
demand
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File name must be unique
across all versioned directories;
database object name must be
unique across all versioned
schemas

Unexpectedly generates files
not marked for promotion (to
match destination
environment to internal image,
which can be out of sync with
actual source)

Command logs available on
server only

Documentation must be
generated using Automated
Publishing



Reports

Jobs

Reports are available on the
workbenches that generate
them, ready for decision support
and troubleshooting

New reports:

Environment (p. 108) - Module
versions promoted to an
environment

Unpromoted Content (p. 108) -
Modules never promoted to an
environment

Comparison (p. 108) of modules
promoted to two different
environments

Audit (p. 108) of files promoted
to an environment vs. actual file
system contents

Change Finder Summary (p. 69)
Job Summary (p. 139)
More flexible scheduling options

Schedule any series of
automated processes in a single
step using the Schedule window
(p. 141)

No browser required on
Codebase server

A single summary email message
is sent describing all changes
made during a job

Start Here 15

To view reports, you must
leave your current workbench
and navigate to other windows

Must run an Oracle Formin a
browser window on Codebase
Server

Separate email messages sent
for each file acted upon
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The View Inside Jobs window's Job status and results are
Log window (p. 139) replaces the displayed in two different
Action Summary window, windows

consolidating job status and

results

Workstation Web browser

3.9 only: Oracle Forms client

Application 10gAS Release 2 3.9 - 6i Forms client/server

server

4.7 - 10gAS Release 1

See the Integra Codebase 4.2 SP1 Release Notes for a complete list of new features.

To get up to speed quickly, review How to use Integra Codebase (p. 11).

As mentioned above, reports are now available on relevant workbenches:

Codebase 4.1

View Reports > View Automated
Change Finder Reports >

View Customizations

View Version Changes

View Oracle Changes
View Error Summary
View Schema Changes

View Reports > View Automated
Publishing Reports >

View Document

View Error Summary

Codebase 4.2

Maintain Versions: Compare To... (p. 54)

Maintain Versions: Compare To... (p. 54);
Change Finder (p. 69)

Change Finder: Compare Time Periods (p. 78)
View Inside Jobs: View Log (p. 139)

Change Finder: Compare Specific Modules (p. 79)

Automated Publishing (p. 124)

View Inside Jobs: View Log (p. 139)



Start Here 17

Installation Status >

View File Status Environment report (p. 108)
Print Environment

Reprocess File Maintain Versions (p. 43): Promote to field
(promote again to the same Environment)

View Errors View Inside Job: View Log (p. 139)
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Login

All Codebase users must begin by logging in using the Welcome to Integra
Codebase window.

i ielcome to Codebase

ORACLE

Integra Codebase™

© 2008 Oracle. All rights reserved. Oracle is a registered trademark of Oracle Corporation andfor its
affiliates. Other names may be trademarks of thelr respective owners.

Username |
Password

To display that window, open a web browser window and visit:

109gAS Release 1 users:
http://hostname:port/forms90/f90servilet?config=codebase

10gAS Release 2 users:
http://hostname:port/forms/frmservlet?config=codebase

.Where:

hostname is the domain name of the web server configured to serve
Codebase

port is the port used to access Codebase on hostname

codebase is the Application Configuration Name chosen during installation
(usually codebase). For more information, see "Integra Installer Worksheet" in
the Integra Codebase 4.2 SP1 Installation Guide.

The window has these fields and buttons:



Username

Password

Login
(button)

Cancel
(button)
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Your Codebase Administrator creates your username.

Your Codebase Administrator creates your password. To change it, log
in, then select Action > Change Password from the menu bar.

Verifies your username and password, and displays the Navigator (p.
20).

Cancels login and closes this window.
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Navigator

22 Jan)
Project PROJECT1 -

= Configuration e—)—-ﬁ_Wurkhenches
tj General " Maintain Versions
Projects " Project Configuration
lhjnhs " Change Finder
Lv’ View Inside Jobs —" Object Finder
=" Publish
e Automation
—" Wersioning
— Generation
—" Change Finder
—+" Publishing
—" Upgrade
G- Jobs
L\/ View Inside Jobs

The Navigator is your gateway to all Codebase windows. To open a window, double-
click its name.

The windows listed depend on the setting of Project, and on your roles and
permissions:

Window Required Role(s)

Configuration:

General (p. 23) Administration

Projects (p. 33) Administration AND Projects
Workbenches:

Maintain Versions (p. 43) Projects

Change Finder (p. 69)
Object Finder (p. 80)
Publishing (p. 92)



Navigator 21

Project Configuration (p. 61) Projects AND
Projects: Users: Admin (p. 34)

Automation:
Versioning (p. 93) Projects AND
Generation (p. 103) Projects: Users: Admin (p. 34)

Change Finder (p. 116)
Publishing (p. 124)

Jobs:

View Inside Jobs (p. 135) Projects: Users: Jobs (p. 34)

The window contains one field:

Project You must select a project prior to double-clicking the name a Codebase
window.

The dropdown contains only the projects that you have been assigned
to (for information about project assignment, see Projects: Users (p. 34)).

If you have been assigned the Administrator role, the Administration
project is listed (for information about role assignment, see General:
Users (p. 25)).
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Administration role

B Mavigator [Alan]

Project Administration -

o Configuration
|::: General
Projects
ll-_ Jobs

L\/ View Inside Jobs

When Project is set to Administration, the Navigator window (p. 20) lists the
windows that let you configure Integra Codebase, its users, and its projects.

In This Section

General 23
Projects 33
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General

ﬁ Mavigator [Alan]

Project Administration -

E}-lﬁ_ Havigate
ll-_ Configuration

Projects

o Jobs

The General window lets you configure Integra Codebase's global settings.

Web Server

Company Name m

Ul Path [u02fapplimationicodebased 2

Oracle Home Path (W01 forachedoroduct Ofr_r2

Forms URL [Hite:Mogicalapps comirelease2

Application Server Name (l0dicalapps.com

Codeb Profile Opti Codeb Datab Infio

Debug Level 5

Report Format POF

Uniz hin Directory | bi
Report Debug Level
‘Wite to Log File

‘Wite to Report Log File Y

DB Setvice Name MI205
Schema “E_ADMIN

n Data Tablespace ©OD_DATA

Index Tablespace COD_INDEX

[

-

This tab contains three groups of fields:

Company Name of your company or organization.
Name

Ul Path Full path on Codebase Server to directory where Integra Codebase
is installed.
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Oracle Home Full path to the Oracle Home of the application server that serves
Path Codebase.

Codebase Profile Options

Debug Level Level of detail in Codebase's application server log. Enter an
integer between 1 and 5; 1 is least and 5 is most. We recommend
using 1 or 2.

Has no effect when Write to Log File is set to N.

Report Default format for reports. The options are:
Format Delimited

HTML
PDF
RTF
XML

Unix bin Unix/Linux users: Full path on Codebase Server to directory where
Directory  the Unix/Linux utility sh is stored.

Windows users: Leave blank.

Report Debug Level of detail in Codebase's report error log. Enter an integer
Level petween 1and 5; 1 is least and 5 is most. We recommend using 1
or2.

Has no effect when Write to Log File is set to N.

Write to Log Enter Y to direct the application server to log Codebase messages;
File  \ to turn off logging.

Environment Unix/Linux users: Full path on Codebase Server to directory where
File (he application server user's environment file is stored. For more
information, see "Before You Install: System Requirements:
Codebase Server: Configuration” in the Integra Codebase 4.2
Installation Guide.

Windows users: Leave blank.
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Codebase Database Info
DB Service Service name of the database that houses the Codebase schema.
Name
Schema Name of the Codebase schema.
Data Tablespace that houses the Codebase schema's tables.

Tablespace

Index Tablespace that houses the Codebase schema's indexes.
Tablespace

Users

Administration -

‘Wieh Server Databases UNIXHosts Email Servers
Password Expires on
Username  Description Pagswiord Email Address Ensbled  Date Mext Login

I m— |Codebase Acministrator |******** |admin@yourcompany.com [ | | | =
|—|ALAN |Alan i : ni@applimation.com [ | [
|—|BARRY |barry |***************** |bgreenhu1@applimatinn COm 7 | [
|—|MARY |Mary |**************** |mcoker@applimaﬁnn.com [ | [
|— |mieE ke e — |mfiippone@spalimation.com i [ ]
|— |KEVIN |Kavin |**** |kbai|ey@solmionbaacon.c:om [ | [
[mEEST — Mchael Best [presmsnssrssnsnss imest@appiimation.com W [ ]
|—|LCHENG |Loreﬂa Cheng |***************** |Icheng@logica\apps.com [ | | |
|—|JPADALA |Jag Paclala |""""""""""""""""" |jpadala@lugicalapps.cum v | [
|— |MDAFTARI |Mayur Daftari |***************** |mdaﬂari@lngicalapps cOom 7 | [
|—|NOPRIVS |User weith mo privs |******* ity |kbai|ey@solmionbaacon.com [ | [
|— |K ALY AMBAT Falyan [ w452 |k handari@logicalanps com " [ [ | 5

Role Start Date  End Date Enahled

Administration [t2e2z008 | W

Adminiztration 05/2352007 v

This tab lets you add and manage Codebase user accounts.

To create a user:

1 Click any Username or any empty row, and click & (Row > Insert). A blank row is

highlighted.

2 Fillin the blank row's fields, and click & (Action > Save).

3 Set the user's Roles as desired, and click & again.

To change a user's information:

1 Change the settings of the user's fields, and click &,
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To disable a user:
Once a user has been created, it cannot be deleted, but it can be disabled, which
prevents login:

1 Uncheck Enabled to the right of the user's Username, and click 2.

The tab contains the following fields:

Username String used by Codebase to identify the user, and entered by the
user when logging in. The string may not contain spaces or any of
these characters:

') /7 =% & @ "t .,
Description Typically the user's full name.
Password The password entered by the user when logging in.

Email The user's email address.
Address

Enabled When checked, the user can log in.

Password Expires On

Date The user will be asked to choose a new password the first time
s/he logs in after this date.

Next Login The user will be asked to choose a new password the next time
s/helogs in.
Roles

Role The user's roles. Roles determine the windows a user can see.
There are two roles: Administrator and Project; for more
information, see Navigator (p. 20).

Start Date The user will have the Role any time s/he logs in after this date.

End Date The user will no longer have the Role any time s/he logs in after
this date.
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Enabled When checked, the user has the role (unless prevented by Start

Date or End Date).

Databases

Web Server

Mame (TS entry) S0

Databases

Hozt

UMNIX Hosts

FPort

l [m |0ra‘1 ils}

|SubscD1

1531

[ |lsupaz03 [sub3203

|zubscot

1521

|—|3ub1Dg |0ra1 g

|Subsc:01

|1531

[Jlsp11510a [sp115104

|Supp0r13

1522

(] |

|
|
|
|
|
(] |
I
|
|

Email Serers

1]

Codebase Agent Details

[ Recreate
[ Privileged

cchema |CE_AGENT_TEST
Pazsword

Agert Tablespace USERS

SYSTEM Password

This tab lets you identify the databases that Codebase can manage.

To add a database:

Click any Name row, and then click =+ (Row > Insert). A blank row is highlighted.

Fill in the blank row's fields, and click & (Action > Save).

Optional: Specify tablespaces in the Tablespaces area, and click & again.

To change a database's settings:

Change the settings as desired, and click 2.

To permanently remove a database:

Remove all references to the database on Automated Versioning's Schemas tab (p. 97),
and Automated Generation's Schemas (p. 109) and File Locations (p. 110) tabs.

Click the database's Name, and then click EX (Row > Delete).
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The tab contains the following fields:

Name (TNS entry) The database's TNS entry on the Codebase Server.
SID The database's SID.
Host The domain name of the database host.

Port The port for accessing the database via the Host.

Codebase Agent Details

Schema Codebase creates an empty schema in the database, with this
name.

Password The password for accessing Schema.

Agent Tablespace Tablespace where Agent will temporarily store data. At least
10MB of free space must be available. The tablespace can be
shared with other applications, or dedicated to Codebase.

Recreate When checked, the Codebase Agent is updated. Use this
when:

An Environment housed in the database has been
refreshed.

You are updating a password.

Privileged When checked, the Codebase Agent can auto-version
schemas that are not normally accessible to Schema.

SYSTEM Password Password of the selected database's SYSTEM user, which is

(tocreate j5e to create the Codebase Agent.
Codebase Agent)



Unix Hosts
B integra Co

Weh Server

Administration -+

Databases UMIX Hosts | Email Servers Tools
Oracle Forms
Huost ﬂ@l S5H Port |22 Hotme Dir MU02foraclehroduct s Ogfr [
Usger [ora10gfr Bin Dir [kin Erry. Script (homedorat Ogfri1 Dgtr env
]| T Tempa Dir timp Wiz
Host Key [subsc0l
Haost (2Upports SEH Port [22 Home Dir (11151 0adorackezpt 151 0aappl
User [sp11510a Bin Dir [kin Erre. Script 11151 0aracle/spt 151 Daapplis]
Pasgword Temp Dir (AmP Wersion .
Host Key [Support Server
1 Host |gaec0s SSH Port [22 Home Dir [homeioracle!
Uszer [oracle Bir Dir [N Erte. Script GAS205 eny
Password [ oo e P
Host Key [oracle@oascls
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Use this tab to specify all Unix/Linux hosts used to connect to Environments' file
system directories and databases (the latter are specified on the Databases tab).

Microsoft Windows users: Windows Environments do not require Hosts. If all
databases managed by Integra Codebase are hosted in Windows Environments,
leave this tab blank. If some are hosted in Windows and some in Unix/Linux,

enter hosts only for databases hosted in Unix/Linux.

To add a host:

Click on any Host row, and then click &+ (Row > Insert). A blank row is highlighted.

Fill in the blank row's fields, and click & (Action > Save).

To change a host's settings:

Change the settings as desired, and click .

To permanently remove a host:
Remove the databases (p. 27) served by the host.

Click the Host, and then click EX (Row > Delete).
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The tab contains these fields:

Host The host's domain name.
Port Port for accessing the database Codebase will manage.

User Codebase logsin as this user when transferring files, using
ssh and scp. Therefore, this user will own the files.

Password User's password.

Bin Dir Full path on host to the directory that holds the operating
system's typical BIN utilities.

Temp Dir Full path on host to directory where Codebase can store files
temporarily.
Oracle Forms

Home Dir Oracle Forms applications (including E-Business Suite)
users: Full path on host to Oracle Forms Home directory.

All others: Leave blank.

Version Oracle Forms applications (including E-Business Suite)
users: Version of Oracle Forms installed on host.

All others: Leave blank.

Env. Script Oracle Forms applications (including E-Business Suite)
users: Full path on host to Oracle Forms compilation
environment file.

All others: Leave blank.
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Email Servers

L L L L L L L L AL L L P L ML L P ML L L P AL L

URIX Hosts

Datahazes Email Servers

Description Port SMTP Username SMTP Pazswword
|Ma|| Server o5 | | xxxxxxxxxxxxxxxxxxxxxxxxxxxxxx =

[ [
| |
| |
| |
: :
: ——
| |
| |
| |
| |
[ [
| |

4|

This tab lets you configure the email servers used by Integra Codebase and the
Codebase Agents to send email messages during automated operations (for more
information, see Projects: Email setup (p. 39)).

To add a server:

Click any Server row, and then click =4 (Row > Insert). An empty row is highlighted.

Fill in the empty row's fields, and click & (Action > Save).

To change a server's settings:

Change the settings as desired, and click &,

To permanently remove a server:
Remove all references to the server on Projects' Email setup tab (p. 39).

Click the Server, and then click = (Row > Delete).

The tab contains these fields:

Server Your outgoing (SMTP) email server. Most SMTP servers have the
following naming convention: smtp . xyz .com

Description Brief description that identifies the server.



Port

SMTP
Username

SMTP Password
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Port used to send email via your outgoing SMTP server.

If your SMTP server requires you to login, enter a valid username.
Some SMTP servers do not require login information when you
are already connected to their network.

If SMTP Username is required, enter the password.
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Projects
Bl Navigator [4lan]
- Havigate

ll-_ Configuration
G

o Jobs

The Projects window lets Codebase Administrators set up projects and assign users to
them. You must have both the Administrator and Project privileges to access this
window.

Projects let you organize logical units of work. At its core, each project is a collection of
Environments that are part of a code promotion hierarchy (e.g., Development, Test,
and Production), and a set of user permissions. For example, each department should
have its own Integra Codebase project, in order to provide control and security.

A Codebase Administrator must create at least one project before anyone can
use Codebase's features.

If you have questions about the processing of files or database schemas, and are
not a Codebase Administrator, contact an Administrator for information.

The upper portion of the window contains fields for choosing projects.

ﬁ FProject Configuration [ALAK_PROJ1]
Description
_J il AN_PROA ALARN_PRO.M
AMARNATH_PRO AMARMNATH_PRO
AMIL_PRCJ ARIL_PRC
AN]_PROJ AN _PRCJ

A _TEST_PRCW support test project

Project The project's name. This name will appear in the title bar of each
window when a project user is logged in.
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Description Could be used to describe why the project was created, or what
content or activities are monitored.

To create a project:

1 Click any Project row, and then click 4 (Row > Insert). A blank row is highlighted.

2 Fillin the blank row's fields, and click & (Action > Save).

To edit a project:
1 Click once on its name; the project's details appear in the tabs below.

Users

ﬁ Froject Configuration [ALAN_PROJ1]

Description
_J i, 1 ALAR_PROM
LMARNATH_PRO AMARMATH_PRO
£NIL_PRCJ ANIL_PRC

AVI_PROJ AVI_PROJ

A _TEST_PRCW support test project u

Lirk Update  File Regen  Update Delete Promote
Usernames Admin Jobs Mo Link Restore Mod “ersion Wetsion  Upto Exclude extensions

| |y 7 7 7] 72 7] 7 7] 7 PROD (&
| |VDELORENZO (JENNIFE! v 4 v i v I 3 I PROD

J r r r r r r r r

_] r r r r r r r r

J r r r r r r r r

_] r r r r r r r r

J r r r r r r r r

_] r r r r r r r r

J r r r r r r r r

_] r r r r r r r r

J r r r r r r r r

_] r r r r r r r r

J r r r r r r r r

_] r r r r r r r r

J r r r r r r r r 5

This tab lets you give Codebase users permission to use the project, and control what
they can do with the project.
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To add a user to a project:
Select the Project in the upper portion of the window.

Click on any Username, and then click & (Row > Insert). A blank row is highlighted.

In the blank row, select the Username, fill in the other fields, and click & (Action >
Save).

To change a user's privileges:
Select the Project in the upper portion of the window.

Revise the user's fields, and click @.

To remove a user from a project:
Select the Project in the upper portion of the window.

Click on the Username, and then click ExX (Row > Delete).

The tab contains the following fields and buttons:

Username Select the user who will have permission to use the project.
Admin Grants access to the Project Configuration (p. 61) window.

Jobs Grants the ability to run the automated processes (by enabling the
Schedule button on the General tabs of their windows).

Consider creating a user with only the Projects role, and
giving this user the sole ability to schedule all projects'
automated processes. By limiting scheduling capability to a
single user, you simplify auditability, and decrease the
chance of scheduling conflicting or duplicative processes
(potential conflicts are described in each process'
documentation). Users are created on the Administration:
Users tab (p. 25).

Link Mod Grants the ability to create records in the Link Modules window (p.
54).
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Grants the ability to update records in the Link Modules window.

Grants the ability to restore file versions (p. 56) in the Maintain
Versions window (p. 43).

Grants the ability to update records (e.g., versions) in the Maintain
Versions window.

Grants the ability to delete versions (p. 53) in the Maintain Versions
window.

Limits how far the user can promote modules (p. 58).

Comma-delimited list of file extensions that the user will NOT be
able to promote.
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Promotions

Configuration [ALAN_PROJ1]

Description
ALAM_PROM
AMARMATH_PRO
AMIL_PRC.
AI_PROJ

support test project u

AMARNATH_PRO
ANIL_PROJ
AVI_PROJ
4VI_TEST_PROJ

Promaotions

~ Environment / Promotion Hierarchy "
Initial
Order Enviranment Stane  Generation
] DEV ] []
17 TEST [ v
IE PROD I W
I r r
_] r r
I r r
~ Oracle AOL Generation Details
Database |gadife1n hd
APPS Schems |APPS APPS Passyyord®
Host | @gasc02 applimati... =
Host User |tasife]0 Host Password*
APPL_TOP Dir aadife Dioracke/aa015E1 Digadite] Dappl
* Leave blank to enter at runtime

This tab lets you define the promotion hierarchy, which is followed when promoting
code from your development Environment to other Environments (and eventually to
your production Environment). Here is an example of a simple promotion hierarchy:

1. Development

2. Test

3. Production

If your project will use Automated Versioning, but not the promotion
mechanism, do not enter any records in this tab.

The Initial Stage checkbox indicates where all code will originate; only one of these
checkboxes can be checked. The Initial Stage Environment should be the one where
developers are creating code.

When defining the promotion hierarchy, the Environments must abide by the
following rule: each non-initial-stage Environment (e.g., TEST, PROD) must correspond
to an Initial Stage Environment (e.g., DEV) by containing matching Compilation
Schemas (see Automated Generation: File Locations (p. 110)).
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To define a project's promotion hierarchy and/or AOL details:
1 Select the Project in the upper portion of the window.

2 Setthe tab's fields as desired, and click (& (Action > Save).

The tab contains these fields and buttons:

Define Environment/Promotion Hierarchy

Order Orderin which code is promoted, starting with the Initial Stage
(e.g., Development).

Environment Name of the Environment.

Initial Stage When checked, identifies the Environment that code originates
from (i.e., the one where development occurs). See above for more
information.

Generation When checked, Automated Generation (p. 103) can perform all of
its functions on the Environment. When unchecked, Automated
Generation only promotes files; it does not run SQL or compile
forms.
Oracle AOL Generation Details
Database TNS entry on the Codebase Server for the Environment's database.
APPS Schema Name of the Oracle E-Business Suite APPS schema (typically APPS).
APPS Password of the APPS schema.
Password

Optional; if you do not enter a value, it will be requested at
runtime.

Host Unix/Linux only: Host used to access the Database.

Host User Unix/Linux only: Username for logging into Host (typically
APPLMANAGER).

Enabled if Host is chosen.
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Host Unix/Linux only: Password for logging in as User.
Password

Enabled if Host is chosen. Optional; if you do not enter a value, it
will be requested at runtime.

APPL_TOP Dir Unix/Linux only: Full path on host to the APPL_TOP directory.

Enabled if Host is chosen.

Email setup

ﬁ Project Configuration [ALAN_PROJ1]

Praoject Description
ALAM_PROM
AMARMNATH_PRC
AMIL_PRO.

ANI_PROJ

support test project u

Email setup

AMARNATH_PRO
ANIL_PROJ
AYI_PROJ
AVI_TEST_PROJ

Enahled

ration Job Information| I -
J Automated Chject Finder Job Information v
J Automsted Publishing Job Informstion [ -
M ge Details
Description: Automated Generation E
From: |awaxman@applimaﬁun.cum Mail Server: [ v]

T [@vwasman@applimation.com

CC:

Message: | o tomated Generatian

This tab lets you configure the email messages generated by the project.

To createa message:
1 Select the Project in the upper portion of the window.

2 Click any Subject row, and then click * (Row > Insert). A blank row is highlighted.

3 Fill in the blank row's fields, and click & (Action > Save).
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To edit a message:

1 Select the Project in the upper portion of the window.

2 C(Click the message's Subject.

3 Revise the message's fields, and click 7.

The tab contains these fields:

Subject

Enabled

Message Details

Description

From

To

Cc

Mail Server

The message's "Subject” header.

When checked, the message can be sent; when unchecked, the
message cannot be sent.

Short description of the message. Appears only on this tab; does
not appear in the message.

Usually the email address of the Project Administrator, so
developers' replies will be sent back to the Administrator.

Email address(es) used when no address can be obtained for the
developer associated with a file in the Link Modules (p. 54) or
Maintain Versions (p. 43) windows. Separate multiple email
addresses with commas.

Email address(es) that should get a copy of the message. Separate
multiple email addresses with commas.

Outbound email server to use. Email servers are specified on the
Administration window's Email Servers tab (p. 31).
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Message The message's body.

All Subject variables (listed above) can be used in Message, as
well as:

sub_comments - Comments in Maintain Versions (p. 43) for the
file being processed.

sub_obj_names - List of objects containing PL/SQL code that
are no longer inherited. This runtime variable is available only
when Automated Publishing (p. 124) sends a warning message
that PL/SQL code is no longer inherited.
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When Project is set to any project's name, the Navigator (p. 20) lists the windows that

let you use the project, and configure project automation.

The Workbenches let you perform Codebase's manual day-to-day operations.

Configurations let you set up and manage Codebase's project automation.

In This Section

Maintain Versions

43

Project Configuration

61

Change Finder

69

Object Finder

80

Publishing

92

Automated Versioning

93

Automated Generation

Automated Change Finder
Automated Publishing

103
116
124
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Maintain Versions

PROJECT1 M Al vergions hd Refresh
K Filename W File Date: Actual Envs Promoteto | Relesse Lakel Developer
3 0472372007 17.31:12|DEY RELEAZE1 ora1 0gir o
AGTableDDL java 2 04i23/2007 17311 2|TEST ey “ersion JGAIKEYIN
AGTableDDL java i 021672007 131110 test AL
AGTableDDL java 1 061012006 02:03:04|DEY test ora1 Ogfr
AMCipherkeyGenerstor o-javasr 4 01/29/2007 14.07:37|DEY java ol Ogfr
AMCipherkeyGenerstor o-javasr 3 01MB/2007 17.00:08 java aralOofr
AMCipherHeyGenerstor o-javasr 2 01 MG/2007 14:06:24 java ol Ogfr
AMCipherkeyGenerstor o-javasr 1 01/09/2007 14:40:37) o] oral Ogfr
AMCiphetParameters o-javast 4 01/29/2007 14.07:37|DEY java oral Ogfr
AMCipherParameters o-javasr 3 (01162007 17.00:07 java ora 0gfr
AMCiphetParameters o-javast 2 01 ME/2007 14:06:24 java orat Ogfr -
PROJECT
(LOCALY 02 iapplimationdey
-
-
Add to Yersioning...| Check Out... Delete Compare To... Link Module... Restore Files... | Mass Update...

This window lets you work with the file and database object versions created by
Automated Versioning (p. 93). You can use it to:

Add a file to versioning (p. 49)

Find a version (p. 48)

View a version (double-click its Filename)

Compare two versions (p. 54)

Add a release number, label and/or comments to a version (p. 48)
Update a field for many versions (p. 57)

Link a file to a version (p. 48)

Associate a custom file with a standard file (Link Modules (p. 54))
Delete a version (p. 53)

Restore deleted version (p. 56)

Check versions out (p. 50) to prevent others from making simultaneous changes,
and check the changed versions back in (p. 52)

Schedule the promotion of versions to other Environments (using the Promote
to field, described below; Automated Generation (p. 103) performs the actual
promotion during its next run)

Your abilities depend on the privileges granted to you by your Codebase
Administrator (in Projects: Users (p. 34)):
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All users assigned to a project are allowed to view the window's information and
the versions themselves. They can also view the log (p. 139), which contains
error messages when files cannot be versioned (e.g., because they are either
opened or locked).

Users with the Update Version privilege can update the following fields: Rev
Num, Label Name, Developer, and Comments.

Users with the Delete Version privilege can delete versions.

Users can promote versions up to Environment specified in their privileges.
Users cannot promote versions that have filename extensions specifically
excluded by their privileges.

The window contains these fields and buttons:

Quick Find:
Project

Quick Find:
Version

Quick Find:
Refresh
(button)

File Name

Vi#

File Date

Filters the modules (i.e., files and database objects) listed below.

This list contains all projects you have been assigned to, and one
other choice: All projects.

Filters the modules listed below.

This list contains all version numbers created by Automated
Versioning, and two other choices: All versions and Latest
version.

Refreshes the modules displayed.

Click this button whenever you suspect that modules have
changed since the last time you selected a Project or Version on
the left.

Shows whether the module has been checked out (and therefore
locked).

Name of the module. This is a query-only field.

Double-clicking this field displays the module, using the
application associated with it in your web browser.

Version number created by this window or Automated Versioning.

Modification date at the time the module was versioned. This is a
query-only field.
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Actual Envs Environments in the promotion hierarchy where the version can be
found. Populated after Automated Generation runs. In order for
this field to show accurate information for the Initial Stage
Environment (e.g., DEV), Automated Versioning must be run prior
to Automated Generation (i.e.,, DEV may not appear on the latest
version of a file if the version was created after Automated
Generation processed the file).

Promote to To schedule the promotion of this version, select the destination
Environment from the dropdown. This dropdown lists only the
Environments that you are allowed to promote to.

You may promote the same version to an Environment more than
once.

Files will not be promoted to a non-initial stage Environment
unless the corresponding Initial Stage Environment has
already processed the file. Therefore, when adding a brand
new file and immediately promoting it to another
Environment, you must run Automated Generation for the
Initial Stage Environment before running it for the non-initial
stage Environment.

Release Can be used to indicate a major release number. The field will
default to the value entered in the Major Release Number field on
Automated Versioning's General tab (p. 95). You should set the
default value before starting new development on a new major
release.

Label Can be used to identify modules that must be promoted as a
group. After a developer assigns a Label to each version that needs
to be promoted, s/he would typically pass the Label to the person
who will promote the modules. That person can quickly identify
the modules to be promoted by querying this field.

To view a list of all values entered in this field, click the field and
press Ctrl-L. Use the list of values to retrieve an existing Label, or
to see whether a proposed Label name already exists.
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Name of the developer responsible for maintaining this version.

A value can be entered manually, but this field is also automatically
updated:

When the module is checked out or in using this page's
Check Out/In button, Developer is set to the user who
checked it out orin.

When the module is versioned by Automated Versioning (p.
93), and the module is a file, Developer is set to the file's
operating system owner.

When the module is versioned by Automated Versioning,
and the module is a database asset, Codebase creates a file
corresponding to each version, and sets Developer to the
operating system user that it uses when creating the files.

To view a list of all users in the current project, and all other
Developer values entered in this field and in the Link Modules
window, press Ctril-L.

If Developer is a Codebase username with Type=Project
User, Codebase can retrieve and use the user's email address
(which is assigned in the Projects window (p. 33)).

The module's project. This is a query-only field.

The host and directory where the file was versioned. This is a query-
only field.

Lets you link the version to a document, tracker request, or any
other external file.

You can enter a full path and filename directly in the field, or select
Edit > Edit Field... from the menu bar for a larger editing area.

To open a linked file, double-click the Link To field. The file will
open based on the operating system file extension association.

The user who checked out the version.

Comments about the version. Anyone given access to this window
can update this field.
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Displays the Add a File to Versioning window (p. 49).

Click on the desired version, and then click this button to open the
Check Out (p. 50) or Check In (p. 52) window.

Enabled only if you have selected a version that you have already
checked out.

Cancels the checkout.

Delete the version from the window, and upon clicking the Save
button, the corresponding record in tsversions will be updated
by setting deleting_for=USER. This action marks the record to
be deleted by the Automated Versioning process. The Automated
Versioning process will delete all records where
tsversions.deleting_for 1S NOT NULL. For each record that
is deleted by Automated Versioning, the corresponding version is
also deleted out of the archive file. This method is used to
accomplish the following objectives:

Developers having access to delete versions via the Maintain
Versions screen no longer need write access to the archive
directory. This provides better security for the archives since
only the Automated Versioning process needs write access.

Performance is greatly increased when a user deletes ten
versions or more.

You can undo deletion before Automated Versioning runs by
clicking the Restore Files button.

Displays the Compare To window (p. 54).

Displays the Restore Files window (p. 56).

Displays the Mass Update window (p. 57).
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Find a Version
Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

Select Query > Enter Query from the menu bar.

Enter values to match in any column(s), in the first row where version information
normally appears.

Select Query > Run Query from the menu bar. The Maintain Versions window
displays matching records.

To once again view all records, enter and run a query without any values.

Add Release, Label and/or Comments
Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

To enter a version's release number: Click the Release field and enter a value.

To enter a label: Click the Label field and enter a value.

Press Ctrl-L to see a list of all values entered in this column.

To enter a comment: click the Comments field and enter your comment.

Click & (Action > Save).

Link a File to a Version
You can link a file to any version. For example, you can link a program specification
document to a version.

This functionality works on Microsoft Windows workstations only.

Select your Project in the Maintain Versions window's (p. 43) Quick Find area.
Click the Filename of the desired version.

Click the Link To field. Select Edit...Edit Field to open the Link To window.
Click the Browse button and select the file that you want to link.

Click OK to close the Link To window.

Click & (Action > Save).
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To open a linked file, double-click the Link To field.

Add to Versioning

Check In

To add a file to versioning:
1 Select your Project in the Maintain Versions window's (p. 43) Quick Find area.
2 Click Add to Versioning. Integra Codebase opens the Add to Versioning window.

3 Enter the following information:

Client Current location of the file. Client is your workstation.
Server

CheckIn File to add to versioning.
Filename

Server Full path to directory where file will be checked in.
Directory

Copy When checked, copies the file to Server Directory. If you do not

.Checked-ln check this box, and do not copy the file manually to Server
File to Server Di A dVersioni 93) will . e
Directory irectory, Automated Versioning (p. 93) will not version the file.

Make When checked, Automated Versioning will write-protect the file

Destination File ¢4, it cannot be updated.
Read-only
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Make Unix/Linux users: Sets the owner's Executable permission to
Destination File TRyE_ |f the file system is on a remote server, the owner is the
Executable Unix/Linux user that Codebase logs in as when working with the
file system, which is set on the Administration window's Hosts tab
(p. 29)). If the server is accessed via NFS, the owner is the NFS
user.

Label Setsthe version's Label field.
Comments Description of file.

CheckIn Applies your settings.
(button)
To discard your settings without adding the file, close this

window.

Click Check In.

To cancel the addition process, close the window.

Check Out

Integra Codebase lets you check out a version, revise it, and check it back in (with an
incremented version number). You can cancel a checkout at any time. Generally, a
version is locked while checked out (see Reserved below).

To check out a version:
Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

Click the Filename of the version that you want to check out, and then click Check
Out. Integra Codebase opens the Check Out window.

BB check oot
Fileriame Syl el

213072006 09:49:16

I




Projects role 51

3 Enter the following information:

Filename
Version
File Date

Client
Directory

Client
Filename

Reserved

Writeable

Check Out
(button)

These display-only fields show the current file version from the main
window.

Enter the appropriate output location where the file should be put.
This field defaults to the last location where the content was
versioned by Automated Versioning.

Enter the filename to use for the checked-out file. This field defaults
to the filename used when the file was last versioned by Automated
Versioning.

Check this box to lock the version.

Check this box if you want the file to be writeable when put into the
file system. If you do not check this option, the file will be read-only
when put into the file system.

Applies your settings, puts the version into the file system, closes this
window, and refreshes the Maintain Versions window (p. 43).

To abandon checkout, close this window before you click this
button.

4 Click Check Out. Integra Codebase responds with a message indicating the success of

your action.

To cancel the checkout process, close the Check Out window before you click its
Check Out button.

To undo a checkout later, select the version in the Maintain Versions window (p.
43), and click Undo Checkout.

To check the version back in after you make changes, see Check In (p. 52).



CheckIn
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EH Checkin-

Undo Checkout Check In

To check in a version that you checked out earlier:

1 Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

2 Click the Filename that you want to check in, and click Check In. Integra Codebase
opens the Check In window, listing the Version, File Date, File Name and Extension
of the File Name that you are checking in.

3 Enter the following information:

Client
Server

CheckIn
Filename

Server
Directory

Copy
Checked-In

File to Server
Directory

Make
Destination File
Read-only

Current location of the version. Client is your workstation.

File to check in.

Full path to directory where file will be checked in.

When checked, copies your modified version to the directory that
Automated Versioning is monitoring. If you do not check this box,
and do not copy your modified version to its original File
Location (shown in the Maintain Versions window (p. 43)),
Automated Versioning will not version the file.

When checked, Automated Versioning will write-protect the file
so it cannot be updated.
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Make Unix/Linux users: Sets the owner's Executable permission to
Destination File TRUE If the file system is on a remote server, the owner is the
Executable Unix/Linux user that Codebase logs in as when working with the
file system, which is set on the Administration window's Hosts tab
(p. 29)). If the server is accessed via NFS, the owner is the NFS
user.

Label Setsthe version's Label field.
Comments Description of the changes made.

Undo Checkout Discards your changes and unlocks the version.
(button)

Check In Applies your settings.

(button)
To discard your settings without checking the version in or

undoing the checkout, close this window.

4 Click Check In.

To cancel the check-in process, close the window.

Delete

The Maintain Versions window lets you delete a version if your username has the
Delete Version privilege. Integra Codebase's performance increases if a given module
(i.e., piece of versioned content) has less than ten versions.

Follow these steps to delete a version:
1 Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

2 C(lick the Filename that you want to delete, and then click Delete Version. Integra
Codebase responds with a message verifying if you want to continue.

3 Click Yes.

4 Click &7 (Action > Save) to commit your action and mark the version to be deleted by
Automated Versioning during its next run.

To undo a deletion before Automated Versioning runs, click Restore Files.
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Compare To
To compare two versions:

Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

Click the Filename that you want to view changes for, and click Compare To....
Integra Codebase opens a list of values displaying the versions that can be compared.

“ersion | File Location

AMCipherPararm = O g Mol OgiCB_AD...

AMCryptoException.o-jay... Jhiomefora Ogfriche 2irojectsmioncayisul OiCE_AD...

AMDstalengthException.o... Shomedorsd Ogfrichd 2projectsMondayisubd OgiCB_AD...
AMKeyGenerationParamet... thomedforad Ogfrichd 2iprojectsMaonday isubd OgiCB_AD...
AMKeyParameter o-javast Jhamesaral 0gfrichd 2irojectsMonday fsub1 0QICB_AD

AMRCAENging o-javast Shomedorsd Ogfrichd 2projectsMondayisubd OgiCB_AD...
AMRuntimeAMCryptoExce.. Jhomejoral 0gfrichd 2iprojectsMondayisubt OgiCB_AD ..

Choose the version you want to compare and click OK. The report appears.

Link Modules

This window lets you associate custom files with standard files (e.g., Oracle E-Business
Suite files) and/or developers.

Automated Change Finder and Automated Generation use these links to determine
which files to process, and how to process them (if your Project uses the Process Only
Linked Modules option).

The links apply to all of the project's Environments.
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To create or modify a link
All users can view the links, but only users with the Projects: Users tab's (p. 34)
Link Mods privilege can add links, and only users with that tab's Update Links
privilege can modify an existing link.

1 Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

2 C(lick Link Modules. The Link Modules window appears.

Based On

3 Enter this information:

Extension Filename extension of custom module (i.e., file or database
object) to be linked. Options include SQL and TXT.

Name Filename (excluding extension) of custom module to be
linked.

Source Name Filename (excluding extension) of the standard module on
which you based your custom module.

Enter TEMPLATE if you created the module from scratch.

Source File Full path to the directory containing the source file.
Location

Primary Developer Developer responsible for maintaining the custom module.

Press Ctrl-L to choose from a list of the project's
developers.

4 Click &7 (Action > Save).
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Restore Files
This window lets you restore or move specific file versions to a new directory location.
Follow the steps below to restore files to a new location.

1 Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

2 C(lick Restore Files. The Restore Files window appears.

ﬁE'E!E:IDIE Files

store Files

File Date

3 Find the files to be restored by entering a Date (and optionally a Stage - i.e.,
Environment) and clicking Find. The window displays the most recent version before
Date of each file that has been marked for deletion by Automated Versioning but not
yet deleted. If a Stage has been entered, the version must have been promoted to that
Environment (i.e., the window displays the most recent version that is before Date and
has Stage listed in the Actual Envs field).

The window displays the following information about each version:

Actual Name of the module (i.e,, file or database object) to restore.
Filename

Version Version to restore. You can change the version being restored.

File Location recorded at the time of versioning. You have the option to
Location hange the location as needed.

File Date Content's modification date when versioning occurred.
Comments Comments about the version, entered by a Codebase user.

Error Errors that resulted from attempting to restore the content. Blank
until you click Restore.
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Click Restore. Integra Codebase returns you to the Maintain Versions window upon
completion, if no errors occur. If errors occur, they are shown in the Error field.

To cancel file restoration close the Restore Files window.

Mass Update

This window lets you update a field's value for all versions currently found in the
Maintain Versions window (p. 43) (even undisplayed records).

To perform a mass update:

Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

Perform a query to display the versions that you want to update. If the query returns
some versions that you do not want to update, you can remove them from list by
selecting them, and then selecting Row > Clear from the menu bar.

Click the Mass Update button. The Mass Update window appears.

Set Update Field to the field you want to update, and Update Value to the value you
want to assign. When the cursor is in the Update Value field, you can usually press
Ctrl-L to view a list of existing values (although some fields do not have such a list).

Click Update.

Once Integra Codebase updates the fields, click & (Action > Save).

To cancel the update, perform a new query without saving.
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Promotion

Prior to using Automated Generation (p. 103) to promote files, generate executables
and/or install SQL in your database, Automated Versioning must version the source
content (aka "modules"). Once versioned, you must mark the modules for promotion
in the Maintain Versions window's (p. 43) Promote to field.

Automated Generation automatically places the specified versions into the
appropriate Environments. Automated Generation does not migrate files unless they
are in one of the locations associated with the Initial Stage. (Therefore, in order for
Automated Generation to migrate a file to your production Environment, it must exist
in your development Environment.)

The Maintain Versions window's Actual Envs field displays the Environments where
the module currently exists. It is populated after Automated Generation runs. In order
for this field to show accurate information for the Initial Stage Environment, your
Codebase Administrator must run Automated Versioning (p. 93) prior to Automated
Generation.

Promote, generate and install code

Follow the steps below to promote code from the Initial Stage Environment to another
Environment.

1 Select your Project in the Maintain Versions window's (p. 43) Quick Find area.

2 For each version that you want to promote, click the Promote to dropdown and select
the Environment to promote to (during the next Automated Generation run).

Integra Codebase assumes that the versions to be promoted exist in the Initial
Stage Environment.

3 Click &7 (Action > Save) to commit your action(s).

To quickly view all versions that have been marked for promotion, click the
Promote to column heading.



10

11

12

Projects role 59

Migrate Application Object Library (AOL) setups

Follow the procedures below to migrate Oracle E-Business Suite 11i Application Object
Library (AOL) setups.

Download the setup

In the Oracle E-Business Suite environment that you are migrating FROM, log into the
responsibility AM Change Manager User.

Run your preferred download program to download the AOL setup you are migrating.
Navigate to the View Requests form to verify that it runs successfully.

Find the downloaded data file in the $AMCM_TOP\out directory.

Wait for Integra Codebase's Automated Versioning (p. 93) to create a version of the
downloaded data file. The new version should appear in the Codebase's Maintain
Versions window (p. 43).

Create a link

In Integra Codebase, select your Project in the Maintain Versions window (p. 43).
Click Link Modules. The Link Modules window (p. 54) opens.

Select Row...Insert Row from the menu bar, and enter the following values:

Module Type The downloaded file's extension.
Custom Module The downloaded file's name (without extension).

Oracle Module TEMPLATE

Click & (Action > Save).

Close the Link Modules window.

Promote the setup

Find the downloaded file's version in the Maintain Versions window.
Click the version's Promote to dropdown, and select the Environment to promote to.
Click &7.

Wait for Automated Generation to promote the data file to the specified Environment.
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Verify the promotion’s results

In the Oracle E-Business Suite Environment that you are promoting TO, log into the
responsibility AM Change Manager User.

Wait for the completion of the concurrent request upload submitted by Automated
Generation (p. 103).

The name of this program begins with the word “Upload,” and ends with the
name of the custom concurrent program, in parentheses.

Ifyou have uploaded an Oracle E-Business Suite Key Flexfield: Compile the Key
Flexfield within your Oracle Environment.

In Integra Codebase's Maintain Versions window, verify that the migrated version's
Actual Envs field includes the destination Environment.
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Project Configuration
ﬁ Mavigatar [Alan]

E}-t Project Havigation
thrkhem:hes

Maintain Versions

Change Finder

Object Finder
Publish
1 Automation
t.lohs

This window lets you perform the same functions as the Configuration: Projects
window (p. 33), but only for the project selected in the Navigator's Project field (p. 20).

Users

ﬁ FProject Configuration [ALAN_PROJ1]
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This tab lets you give Codebase users permission to use the project, and control what
they can do with the project.
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To add a user to a project:
Select the Project in the upper portion of the window.

Click on any Username, and then click & (Row > Insert). A blank row is highlighted.

In the blank row, select the Username, fill in the other fields, and click & (Action >
Save).

To change a user's privileges:
Select the Project in the upper portion of the window.

Revise the user's fields, and click @.

To remove a user from a project:
Select the Project in the upper portion of the window.

Click on the Username, and then click ExX (Row > Delete).

The tab contains the following fields and buttons:

Username Select the user who will have permission to use the project.
Admin Grants access to the Project Configuration (p. 61) window.

Jobs Grants the ability to run the automated processes (by enabling the
Schedule button on the General tabs of their windows).

Consider creating a user with only the Projects role, and
giving this user the sole ability to schedule all projects'
automated processes. By limiting scheduling capability to a
single user, you simplify auditability, and decrease the
chance of scheduling conflicting or duplicative processes
(potential conflicts are described in each process'
documentation). Users are created on the Administration:
Users tab (p. 25).

Link Mod Grants the ability to create records in the Link Modules window (p.
54).
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Grants the ability to update records in the Link Modules window.

Grants the ability to restore file versions (p. 56) in the Maintain
Versions window (p. 43).

Grants the ability to update records (e.g., versions) in the Maintain
Versions window.

Grants the ability to delete versions (p. 53) in the Maintain Versions
window.

Limits how far the user can promote modules (p. 58).

Comma-delimited list of file extensions that the user will NOT be
able to promote.
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Promotions

Configuration [ALAN_PROJ1]

Description
ALAM_PROM
AMARMATH_PRO
AMIL_PRC.
AI_PROJ

support test project u
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AVI_PROJ
4VI_TEST_PROJ

Promaotions

~ Environment / Promotion Hierarchy "
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] DEV ] []
17 TEST [ v
IE PROD I W
I r r
_] r r
I r r
~ Oracle AOL Generation Details
Database |gadife1n hd
APPS Schems |APPS APPS Passyyord®
Host | @gasc02 applimati... =
Host User |tasife]0 Host Password*
APPL_TOP Dir aadife Dioracke/aa015E1 Digadite] Dappl
* Leave blank to enter at runtime

This tab lets you define the promotion hierarchy, which is followed when promoting
code from your development Environment to other Environments (and eventually to
your production Environment). Here is an example of a simple promotion hierarchy:

1. Development

2. Test

3. Production

If your project will use Automated Versioning, but not the promotion
mechanism, do not enter any records in this tab.

The Initial Stage checkbox indicates where all code will originate; only one of these
checkboxes can be checked. The Initial Stage Environment should be the one where
developers are creating code.

When defining the promotion hierarchy, the Environments must abide by the
following rule: each non-initial-stage Environment (e.g., TEST, PROD) must correspond
to an Initial Stage Environment (e.g., DEV) by containing matching Compilation
Schemas (see Automated Generation: File Locations (p. 110)).
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To define a project's promotion hierarchy and/or AOL details:
1 Select the Project in the upper portion of the window.

2 Setthe tab's fields as desired, and click (& (Action > Save).

The tab contains these fields and buttons:

Define Environment/Promotion Hierarchy

Order Orderin which code is promoted, starting with the Initial Stage
(e.g., Development).

Environment Name of the Environment.

Initial Stage When checked, identifies the Environment that code originates
from (i.e., the one where development occurs). See above for more
information.

Generation When checked, Automated Generation (p. 103) can perform all of
its functions on the Environment. When unchecked, Automated
Generation only promotes files; it does not run SQL or compile
forms.
Oracle AOL Generation Details
Database TNS entry on the Codebase Server for the Environment's database.
APPS Schema Name of the Oracle E-Business Suite APPS schema (typically APPS).
APPS Password of the APPS schema.
Password

Optional; if you do not enter a value, it will be requested at
runtime.

Host Unix/Linux only: Host used to access the Database.

Host User Unix/Linux only: Username for logging into Host (typically
APPLMANAGER).

Enabled if Host is chosen.
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Host Unix/Linux only: Password for logging in as User.
Password

Enabled if Host is chosen. Optional; if you do not enter a value, it
will be requested at runtime.

APPL_TOP Dir Unix/Linux only: Full path on host to the APPL_TOP directory.

Enabled if Host is chosen.

Email setup

ﬁ Project Configuration [ALAN_PROJ1]

Praoject Description
ALAM_PROM
AMARMNATH_PRC
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Description: Automated Generation E
From: |awaxman@applimaﬁun.cum Mail Server: [ v]

T [@vwasman@applimation.com

CC:

Message: | o tomated Generatian

This tab lets you configure the email messages generated by the project.

To createa message:
1 Select the Project in the upper portion of the window.

2 Click any Subject row, and then click * (Row > Insert). A blank row is highlighted.

3 Fill in the blank row's fields, and click & (Action > Save).
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To edit a message:

1 Select the Project in the upper portion of the window.

2 C(Click the message's Subject.

3 Revise the message's fields, and click 7.

The tab contains these fields:

Subject

Enabled

Message Details

Description

From

To

Cc

Mail Server

The message's "Subject” header.

When checked, the message can be sent; when unchecked, the
message cannot be sent.

Short description of the message. Appears only on this tab; does
not appear in the message.

Usually the email address of the Project Administrator, so
developers' replies will be sent back to the Administrator.

Email address(es) used when no address can be obtained for the
developer associated with a file in the Link Modules (p. 54) or
Maintain Versions (p. 43) windows. Separate multiple email
addresses with commas.

Email address(es) that should get a copy of the message. Separate
multiple email addresses with commas.

Outbound email server to use. Email servers are specified on the
Administration window's Email Servers tab (p. 31).
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Message The message's body.

All Subject variables (listed above) can be used in Message, as
well as:

sub_comments - Comments in Maintain Versions (p. 43) for the
file being processed.

sub_obj_names - List of objects containing PL/SQL code that
are no longer inherited. This runtime variable is available only
when Automated Publishing (p. 124) sends a warning message
that PL/SQL code is no longer inherited.
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Change Finder
E Mavigatar [Alan]
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ll-_ Jobs

Change Finder detects changes in forms, menus, reports, libraries, text files, database
objects, and entire database schemas. It identifies all differences between files or
objects, and displays them in easy-to-read reports.

Change Finder can be useful to nearly everyone in your information systems
department. It is handy for resolving differences between Environments, and finding
changes to a given form, report, or library.

DBAs use it to determine where database schemas are out of sync. This is
valuable when your Test database needs to match your Production database,
but for unknown reasons they don't. Change Finder can tell you all of the
differences between the two schemas. It can also display files that contain
PL/SQL that is no longer inherited, making it easy to determine whether any
PL/SQL properties have been accidentally overwritten.

Operations personnel use it to determine if there is a problem in the production
schema compared to another baseline schema (e.g., development, test, etc.).

Testers can view detailed differences between a Baseline (Original) Form/Report
and a Changed (Customized) Form/Report. It also allows them to verify that their
database schema matches the developer's database schema.

Code Review Teams can view detailed differences between a Baseline (Original)
Form/Report and a Changed (Customized) Form/Report so the entire team does
not have to walk through every line of code.

Programmers and Analysts can see the changes that have occurred in forms,
reports, libraries, database objects, and schemas when compared to other
Environments or versions.
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Change Finder cannot run concurrently with itself, Automated Publishing, or
Automated Change Finder.

Helpful hints

e When comparing one object or file to another, the names do not have to
match; therefore, you can compare two procedures or procedures with
different names.

e Aswith all Project windows, this window is monitored to ensure that the
maximum concurrent user license is not exceeded. The concurrent user count
is incremented each time this window is opened. The concurrent user count is
decremented when you exit the window. If the window does not exit normally
(e.g., computer turned off or crashed, or program aborted), the concurrent
user count will not be decremented. The abnormal terminations will
automatically be cleaned up the following day when someone exits Change
Finder normally. In the meantime, excessive abnormal terminations of
windows may keep developers from accessing windows until the following
day. Simply entering the window and exiting again will start the cleanup
process.

e Because of the cleanup process described above, you should never leave the
Change Finder running overnight, because internal data will be deleted the
next time someone exits the Change Finder.

Automated Change Finder (p. 116) calls Change Finder; thus, the nightly batch
process could also delete your Change Finder data.

Troubleshooting
Change Finder informs you when it is unable to analyze files. When it does, use the
following troubleshooting techniques:

Form, Menu or Library Comparison Problems

In the event that Change Finder cannot analyze an Oracle form, menu or library, follow
these steps:

Open the file using Oracle Forms Builder. If you encounter errors when opening the
file, resolve the errors and rerun the comparison.
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Verify that the Start In directory for the Oracle Forms Builder icon is set to the
<ORACLE_HOME>/Dbin directory. Attempt to open the file again using Oracle Forms
Builder. If you encounter errors when opening the file, resolve the errors and rerun the
comparison.

Look for error files (which have the extension .err) in the temporary directory specified
in the General tab's (p. 76) Temp Dir field for your project. If error files exist:

a. Open and review the error files.
b. Resolve all errors.

¢. Rerun the comparison.

Report Comparison Problems

In the event that Change Finder cannot analyze an Oracle report, follow these steps:

Open the file using Report Builder. If you encounter errors when opening the file,
resolve the errors and rerun the comparison.

Save the report to the database within Reports Builder. If you encounter errors when
opening the file, resolve the errors and rerun the comparison.

Verify that the Start In directory for the Report Builder icon is set to the
<ORACLE_HOME>/bin directory. Attempt to open the file again using Oracle Reports
Builder. If you encounter errors when saving the report to the database, resolve the
errors and rerun the comparison.

Look for error files (which have the extension .err) in the temporary directory specified
in the General tab's (p. 76) Temp Dir field for your project. If error files exist:

a. Open and review the error files.
b. Resolve all errors.

¢. Rerun the comparison.



Projects role 72

Object types and properties supported when comparing schemas

Object Type
DB Links (Private)

DB Links (Public)

Directory Objects

Functions
Packages
Procedures

Grants

Indexes

Indexed Columns

Index Partitions

Index Partition Key
Columns

Modified Properties' and Source
host, username (dba_db_links)
host, username (dba_db_links)

Public DB links are only analyzed when comparing SYSTEM
schema.

directory_path (dba_directories)

Directories are always owned by SYS; thus, the SYS schema
must be compared to see this type of object.

status (dba_objects), text” (dba_source)

status (dba_objects), text” (dba_source)

status (dba_objects), text” (dba_source)

grantable (dba_tab_privs)

Shows object privileges granted to users or PUBLIC.

Granting READ on a Directory object will only appear when
comparing the SYS schemas.

table_name, status, index_type, and uniqueness
(dba_indexes); locality, partitioning_type,
subpartitioning_type (dba_part_indexes)

descend, column_position (dba_ind_columns)

Indexed columns appear as children of an index. Column
expressions will appear as a column. So UPPER(DEPT) would
appear on the report as a column much like DEPT_ID would
appear on the report.

partition_position, high_value, tablespace_name, status
(dba_ind_partitions)



Index Subpartitions

Index Subpartition
Key Columns

Java Class
Java Resource
Java Source
Library Objects

Materialized View
Logs

Operators

Operator Bindings

Operator Binding
Arguments

Operator Ancillary
Bindings

Sequences

Synonyms (Private)

Synonyms (Public)
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partition_position, tablespace_name, status
(dba_ind_subpartitions)

status (dba_objects)

status (dba_objects)

status (dba_objects), text’ (dba_source)
file_spec, dynamic, status (dba_libraries)

rowids, filter_columns, primary_key (dba_snapshot_logs)

function_name, implementation_type_schema,
implementation_type, return_schema, return_type
(dba_opbindings)

argument_type (dba_oparguments)

increment_by, min_value, max_value, order_flag, cycle_flag

(dba_sequences)
table_owner, table_name, db_link (dba_synonyms)

table_owner, table_name, db_link (dba_synonyms)

Public synonyms are only analyzed when comparing SYSTEM

schema.



Tables and
Materialized Views

Table and
Materialized View
Columns

Table and
Materialized View
Partitions

Table and
Materialized View
Partition Key
Columns

Table and
Materialized View
Subpartitions

Table and
Materialized View
Subpartition Key
Columns
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temporary, iot_type, nested, row_movement, partitioned
(dba_tables); partitioning_type, subpartitioning_type
(dba_part_tables); compile_state, refresh_mode,
refresh_method, build_mode, master_link, rewrite_enabled,
rewrite_capability, fast_refreshable, last_refresh_type,
after_fast_refresh, staleness, query, updatable (dba_mviews)

Properties obtained from dba_part_tables will only appear
when the Include Partition Comparison checkbox is
checked.

Properties obtained from dba_mviews will only appear for
tables that are Materialized Views. The query property will
appear under the "Modified Source" section of the report.

data_type, data_precision, data_scale, data_length,
data_type_mod, data_default, nullable (dba_tab_columns)

partition_position, high_value, tablespace_name
(dba_tab_partitions)

partition_position, tablespace_name
(dba_tab_subpartitions)



Table and
Materialized View
Constraints
(includes Primary
Keys, Foreign Keys,
Check Constraints,
and Unique
Constraints)

Table Constraint
Columns
(includes Primary
Keys and Foreign
Keys)

Triggers

Types

Type Attributes

Type Bodies

Views
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status, delete_rule, r_owner, r_constraint_name, validated,
rely, bad, deferred, deferrable, search_condition
(dba_constraints)

Constraints will appear on the report under their respective
tables.

Primary keys are matched based on existence, not name. This
allows primary keys to have system generated names.
However, foreign key, check, and unique constraints are
match based on their name; thus, user-defined names should
be used when defining these types of constraints. Using
system generated names can cause the report to show a
constraint as Deleted and New because it contains different
system generated names.

column_name (dba_constraints)

Column positions are used for matching so the property
change could show a different column_name in position 1
(or position 2, 3, 4, etc.)

Constraint columns will appear as Deleted or New on the
report under its parent constraint.

status (dba_triggers), status (dba_objects)
status (dba_objects), text” (dba_source)

"text" shown from dba_source will show the same
information as Type Attributes but in a different format.
Besides showing Type Attributes information, other
pertinent information could also be displayed.

attr_type_name, precision, scale, length, and attr_type_mod
(dba_type_attrs)

status (dba_objects), text” (dba_source)

view_type_owner, type_text, oid_text (dba_views); status
(dba_objects); "Check Option" and "Read Only" constraints
(dba_constraints)
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Views Columns data_type, data_precision, data_scale, data_length,
data_type_mod, nullable (dba_tab_columns)

' See Oracle Documentation for more information on Static Data Dictionary views and
field definitions.

*The procedure source for this object (dba_source. txt) is not considered to be
changed if the only lines that contain changes are those that begin with $Header :.
This is intended to ignore the version number and timestamp that exists in all
procedure source for the Oracle Applications; quite often, they change when no other
changes exist in the procedure.

General

@ Change Finder for PROJECT

Mame Dre=scription Compare

General

Temp D |

Host Ci Options
{ Run Before | ‘

Run After |

The upper portions of the page contains these fields:

Name Name of stored Change Finder settings.
Description Description of stored Change Finder settings.
Compare Selecteither:
Compare Specific Modules displays the Modules tab (p. 79).

Compare Time Periods displays the Directories tab (p. 78).
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The General tab contains the following fields and buttons:

Forms Version Enter a value to limit forms listed in search results to the specified
version.

Temp Dir Full path to a directory on Codebase Server where Codebase can
temporarily store files.

Host Command Options

Run before This command is used to run a program before Change Finder runs.
This command is useful for interfacing to other programs and will wait
until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

Run after This command is used to run a program after Change Finder runs. This
command is useful for interfacing to other programs and will wait
until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

View Changes Displays a report of all changes.
(button)

Run Performs the search. When the search is complete, a report of all
(button) hanges appears, and the View Changes button is enabled.
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View Changes
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Lists all files that were tested; files marked Identical have not changed.

Directories

ﬁ Change Finder for PROJECTT

Mame ) ion Compare

_J Time Periocs x|~
-

Directories

Cruler Yersioned Location Changed Time Crigingl Time Ensbled

=

|| — |- - - |

o i N B B

This tab appears when Compare is set to Compare Time Periods. It letsyou
compare how a directory's content has changed over time. Select one or more
Versioned Locations, and for each, enter the Changed Time and Original Time.
Codebase will compare the latest version modified before or at Changed Time to the
latest version modified before or at Original Time. Enter the time in the format
MM/DD/YYYY hh24:mm:ss
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Modules

BHch

Mame

ge Finder far PROJECT

Compare

Specific Modules

- Changed ~ Original
Compare Type Compare Type
® Full File
" ergion HUSll " ersion HUSll
" Schema " Schema
File |

Fie |

This tab appears when Compare is set to Compare Specific Modules. It lets you

specify the content to compare. One each side of the tab (Changed and Original),
select one of the following:

Full File - specify the File, and the Host used to access it.

Changed
Compare Type
® FulFie
o -
T wersion [
File |
T Schema

Version - choose a version to compare

Changed

Compare Type
" Full File

2
" Schema

Schema - choose a Schema to compare, and optionally specify a single Object
to compare.

Changed

Compare Type
" Full File
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Object Finder

ﬁ Mavigator [Alan]
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Object Finder provides interactive, comprehensive impact analysis for scheduled code
changes to forms, reports, menus, libraries and PL/SQL code. Using Object Finder, you
can search for:

Procedures: Search for a text string in stored procedures

Files: Search for a text string in files (forms, reports, libraries, text files, etc.) for
text strings

DB Dependencies: Search for database object dependencies
Subclassed Forms: Search for subclass relationships
Attached Libraries: Search for attachments between forms and libraries

This window can assist you in performing impact analysis. Consider the following
example: you are asked to modify a library but are concerned that it may cause other
forms or libraries to work incorrectly. This screen allows you to see all of the forms and
libraries that have this library attached to them. If no forms or libraries are found, you
can then be assured that there will be no impact to other forms and libraries. On the
other hand, if the query returns forms and libraries, you know that modifying this
library could have an impact on them. Once you have made your changes, you might
want to retest these forms and libraries to ensure that they still work correctly.

This window will also help you determine how many modules will be affected by a
proposed customization. When planning a customization, query on the affected
modaules to get a list of modules that may also be affected. Using this screen while
planning your customizations will increase the accuracy of your plans and budgets.
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Do not run more than one session of Object Finder at once on your workstation.

The results of a query in the Subclassed Forms tab will return only those objects
that are one hop away. Subclassing more than one hop away occurs when an
object that is subclassed from Form A into Form B is again subclassed from Form
B into Form C. In this case, entering a query for the object in Form A would NOT
retrieve the object in Form C, because it is two hops away. If you need to find
subclassed objects that are more than one hop away, refer to
\CMO\customer\objfnd.sql. This script is capable of showing subclassed
objects that are any number of hops away.

Procedures

Frocedures DB Dependencies Suhclassed Forms = Attached Libraries

Search Stored Procedures for

Database | Owvner |
Chject Name | Type |
Text | [ Case Sensitive
Showe # of Lines Before or After |0 [ Sort Resutts [Slover])
Crvner Type Mame Line  Text

=

Download Results

This tab lets you find stored procedures that contain a specified text string. Optionally,
you may specify additional criteria for limiting your query.

The information on this tab is always current, because it is extracted directly from your
database. Because many records could match your query, they are fetched as you
view/scroll them. This tab also lets you view an entire stored procedure by entering
Owner, Name and Type.

To perform a search:
In the Navigator window (p. 20), select the Project to search.

Double click Project Navigation > Workbenches > Object Finder. The Object
Finder window opens, with this tab (Procedures) displayed.
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3 Select the database to search in the Database field.

4 Enter the information to search for (all fields are optional, but enter information in at
least one):

Owner Schema that owns the stored procedure.
Name Stored procedure's name.

Type Stored procedure's type (e.g., function, package, etc.).

Click Ctrl-L to see a list of available procedure types.

Line Line number shown in the text of the PL/SQL field.

PL/SQL Text within one line of the stored procedure.

For faster processing, also enter Owner and/or Name when
specifying PL/SQL.

5 You can also choose either of these options:

Show # of Lines Enter any positive integer to display the lines before and after
Before or After o5ch matching line.

Case sensitive When checked, Object Finder matches capitalization exactly.

6 Click Search.

7 To save a report of your results, click Download Results.
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This tab lets you find all database objects that subclass a specified object. The
information on this tab is always current, because Object Finder extracts this

information directly from your database.
To perform a search:

In the Navigator window (p. 20), select the Project to search.

Double click Project Navigation > Workbenches > Object Finder. The Object

Finder window opens.

Click the DB Dependencies tab.

Enter the database name containing your objects in the Enter Database: field.

Select the database to search in the Database field.

Enter the information to search for (all fields are optional, but enter information in at

least one):

Owner Schema that owns the stored procedure.

Type Stored procedure's type.

Click Ctrl-L to see a list of available procedure types.

Name Stored procedure's name.
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7 Click Search. The following information is displayed:

Owner Schema that owns the referenced object
Type Type of the referenced object
Name Name of the referenced object
Link Database link used to access the referenced object
Used By: Owner Owner of the referencing object
Used By: Type Type of the referencing object

Used By: Name Name of the referencing object

8 To save a report of your results, click Download Results.
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Files
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This tab lets you find forms, reports, libraries and any other file types that contain a
given text string. You can view any file listed in the results area by double-clicking its
name in the File column.

To perform a search:
In the Navigator window (p. 20), select the Project to search.

Double click Project Navigation > Workbenches > Object Finder. The Object
Finder window opens.

Click the Files tab.

Enter the text to find in the Text field. Regular expressions are accepted. Capitalization
is ignored unless you check Case sensitive.

Take care when entering the characters shown below, which have special regular
expression meanings in this field. To search for any of these characters, precede them
with backslashes (\). For example, to search for WHEN-NEW-FORM- INSTANCE, enter
WHEN\-NEW\-FORM\- INSTANCE.

| between expressions finds strings that match either the first expression OR
the second expression. As many as ten expressions can be combined this way.

~ as the first character of the pattern forces matches to beginnings of lines.
$ as the last character of the pattern forces matches to ends of lines.
. anywhere in the string matches any single character.

* after an expression matches zero or more occurrences of that expression.
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+ after an expression matches one or more occurrences of that expression.
- after an expression optionally matches that expression.
[characters] matches any of the characters, but no others.

[character1-character2] matches the range of characters between character1
and character2.

[~characters] matches any character except the characters in the brackets.
\< matches the beginning of a word.

\> matches the end of a word.

\b matches the backspace character (ASCIl code 8).

\n matches the new line (or line feed) character (ASCll code 10).

\f matches the form-feed character (ASCll code 12).

\r matches the carriage return character (ASCIl code 13).

\t matches the horizontal tab character (ASCIl code 9).

\character matches the character, as explained above.

5 Enter the directory or filename that you want to search in the Server Directory field.
You can specify wildcards using asterisks (*). Object Finder searches files with the
extension FMB, PLL and RDF if you do not specify a file extension or use * in place of
the extension.

To search PDF files, we recommend using Adobe Acrobat to ensure accurate results.

6 You can choose any or all of these options:

Include When checked, also searches Server Directory's
Subdirectories ¢ pirectories, and all descendent subdirectories.

Show Zero Hits When checked, displays both the files that contain Text and
those that do not. The Hits field will display O (zero) for all files
that do not contain Text.

Case sensitive When checked, matches the capitalization of Text exactly.

Search Results When checked, searches the files already listed in the results
area for the current Text. Use this option to find files that
match two or more text strings.
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7 Click Search. Object Finder responds with a message stating the number of files
searched, and the number of files that contain Text. The results area shows the
following information:

Hits Displays the number of times that the text string was found in
the file.

Sometimes the number of Hits in a form or report is more
than you can find when you perform a manual search. This
is because Oracle sometimes leaves obsolete text in the
binary files. To make the number of hits match, convert the
binary file (FMB/RDF) to a text file (FMT/REX), and then back
again. Rerunning the search will now give accurate results.

File Displays the name and directory location of the file that
contained the text string. These same results will be written to a
tab-delimited file for printing and mailing purposes (file location
will be shown at the end of your search).

Double-click on this field to open the file using the associated
application in your workstation's operating system. If no
application is associated to this file, the file will not open.

8 To save a report of your results, click Download Results.
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Subclassed Forms
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This tab lets you find dependency information for forms subclassed by other forms,
and/or forms that subclass other forms.

Your Codebase Administrator must run Automated Publishing (p. 124) to populate
this tab with your Project's data. Automated Publishing should be scheduled to run
nightly, to keep the information current.

This tab will only return objects that are one hop away. Subclassing more than one
hop away occurs when an object that is subclassed from Form A into Form B is again
subclassed from Form B into Form C. In this case, entering a query for the object in
Form A would not retrieve the object in Form C, because it is two hops away. If you
need to find subclassed objects that are more than one hop away, use
\CMO\customer\objfnd.sql, which is capable of showing subclassed objects
separated by any number of hops.

To perform a search:
In the Navigator window (p. 20), select the Project to search.

Double click Project Navigation > Workbenches > Object Finder. The Object
Finder window opens.

Click the Subclassed Forms tab.
Unix Environments only: Select Host.
Set the directory to search in File Location.

Set the Dependency Name to the name of the object that depends on the object
being searched for.
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7 You can choose this option:

Include
Subdirectories

When checked, also searches Server Directory's
subdirectories, and all descendent subdirectories.

8 Click Search. The results contain the following information:

Form
Object Type

Object Name

Subclassed By:
Form

Subclassed By:
New Object Name

Name of the subclassed form.
Type of the subclassed form.

Name of the subclassed object - e.g., Trigger Name, Alert
Name, Block Name, Canvas Name, Editor Name, LOV Name,
orObject Group Name.

For example, the Oracle E-Business Suite form APPSTAND
contains a standard toolbar that most forms use. This toolbar's
Object Name is STANDARD_ TOOLBAR.

Dot notation is used to represent child level objects. For
example, DEPTS_DEPT_NO.WHEN-VALIDATE-ITEM describes
the WHEN-VAL IDATE- I TEM trigger on the item DEPT_NO that
resides in block DEPTS.

Name of the form that subclasses the subclassed form.

Name of the subclassed object within the subclassing form.

After subclassing an object, its possible to change the name of
the subclassed object. If the subclassed object was renamed,
the new name will appear in this field.

9 To save a report of your results, click Download Results.
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[ Include Subdirectories

|»

-

Download Results

This tab lets you find all forms, libraries and menus that use a given library.

Your Codebase Administrator must run Automated Publishing (p. 124) to
populate this tab with your Project's data. Automated Publishing should be

scheduled to run nightly, to keep the information current.

To perform a search:

-

In the Navigator window (p. 20), select the Project to search.

2 Double click Project Navigation > Workbenches > Object Finder. The Object

Finder window opens.

w

Click the Attached Libraries tab.
4 Unix Environments only: Select Host.

5 Set the directory to search in File Location.

(<))

Set the Library Name to search for.

7 You can choose this option:

Include When checked, searches Server Directory's subdirectories, and all
Subdirectories joscendent subdirectories (as well as Server Directory itself).

8 Click Search. The results contain the following information:
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Library Name of the library.

Attached to: Name of the form, library or menu using the Library. Opening this
Module object in Oracle Forms Designer would show Library as an
attached library.

When querying on this field, you should enter a value for Type
because a form and a library could have the same names.

Attached to: Type of file identified in Attached to: Module (e.g., form, PL/SQL
Type library, menu).

9 To save a report of your results, click Download Results.
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Publishing

<hench for Monday

Publishing Module

This window generates documentation of a single modaule (i.e., file or database object).
It contains these fields and buttons:

Server Server containing the module to be documented.
Filename Full path and name of file to be documented.

Forms Enter the Oracle Forms path environment variable (e.g.,
Path FORMS90_PATH) if Filename is a form (e.g., FMB, PLL, MMB).

Forms Select an Oracle Forms version if Filename is an Oracle binary file (e.g.,
Version yg p(, MMB).

Report Select the report's format:
Format Delimited

HTML
PDF
RTF
XML

Generate Displays the report in a new window.
(button)
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Automated Versioning
ﬁ Mavigatar [Alan]

| PROJECT -

E!—lﬁ_Prnject Havigation
lli_WurkIJem:hes
o Automati

Generation
Change Finder
Publishing
Upgrade

ll-_ Jobs

Automated Versioning provides transparent version control by searching your
application directories and databases, and automatically versioning changed files and
database objects. It is a batch job that can be run manually on demand, or as a
scheduled recurring job. The following modules (i.e., files and database objects) will be
versioned:

Files with the extension FMB, INP, RDF, or PLL

File with extensions specified in the File Locations tab (p. 99)
But not files specifically excluded on the Filters tab (p. 102)
Database object types specified in the Schemas tab (p. 97)

Typically, you should run Automated Versioning on modules in your Initial Stage (i.e.,
development) Environment. If you want to use Automated Versioning to monitor
other Environments, such as test or production, create a separate project for each
Environment.

To use Automated Versioning:

As with all automated processes, you must have the Projects: Users tab's (p. 34)
Admin privilege to configure and schedule this process, and the tab's Jobs
privilege to view its execution status and logs.

1 Inthe Navigator window (p. 20), select your Project.

2 Double-click Project Navigation > Configurations > Automated Versioning.
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3 Configure the window's tabs (General (p. 95), Schemas (p. 97), File Locations (p. 99)
and Filters (p. 102)).

4 C(lick the General tab's (p. 95) Schedule button. The Schedule (p. 141) window
appears.

5 Set all scheduling options as desired; you can run Automated Versioning once, or
repeatedly. For example, you can version content every five minutes between 6am
and 9pm.

If you are versioning database objects, the Environment's database must be
running in order for Automated Versioning to function properly.

You cannot run more than one instance of Automated Versioning at the same
time, unless they are for separate projects. Automated Versioning can run
concurrently with any other process.

6 Click the Schedule button. A new job is created; its activities can be monitored in the
View Inside Jobs window (p. 135) window and its log (p. 139).

When errors occur in the attempt to version a file because the file is open or locked, an
error will be written to the log (p. 139). The program can be restarted at any time after
a problem or system crash has occurred. The program will start processing where it left
off.

7 After verifying that Automated Versioning has run successfully, view the Maintain
Versions window (p. 43). This window lets you maintain, promote, and restore versions
of a given program.

8 If you have scheduled repeated execution of Automated Versioning, check the log (p.
139) periodically to ensure that no errors occur.
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General
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This tab lets you configure Automated Versioning.

All values entered in this tab will take effect after Automated Versioning is closed and
restarted.

Versioning Options

Archive This directory will be defaulted to a directory created by Codebase
Location ,n, your Codebase Server at the time the project was created. This
directory stores the archives of each module. Make sure there is
plenty of disk space in this file location. All files being placed in this
directory will have the same name as the file being archived plus an
additional extension of .z

Thus, the location specified must handle long file names.

If you decide to change the default value, the directory must
exist, be readable and writeable. Otherwise you will receive an
error message.

Temp Full path on Codebase Server to directory where Codebase can
Directory temporarily store files.

Versions to Enter the number of versions of each file to keep, or leave blank to
Keep eep all versions.
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Use this value to distinguish between major releases. The value will
be set by default, and will be displayed and editable in the
Maintain Versions screen.

When checking in a file (p. 52), the user must enter a value in the
Label field.

The version of Oracle Forms used in the Environment. Used when
Compare Content is checked.

When checked, Automated Versioning compares the actual
contents of the modaule (i.e., file or object) rather than comparing
only timestamps. Choosing this option can increase precision, but
can also make Automated Versioning take dramatically longer.

Host Command Options

Run before

Run after

This command is used to run a program before Automated Versioning
runs. This command is useful for interfacing to other programs and
will wait until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

This command is used to run a program after Automated Versioning
runs. This command is useful for interfacing to other programs and
will wait until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).
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Schedule Begins the process of scheduling Automated Versioning. Displays the
(button) schedule window (p. 147).

Schemas
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This tab allows you to specify the schemas upon which to perform Object Versioning.
Automated Versioning will first perform an extraction of DDL for the schema objects
specified in this tab. The DDL will be placed into files using the extensions defined in
the Db Object Types section. The files will then be versioned just like the other files
that Automated Versioning processes. All values entered in this tab will take effect
immediately (restarting Automated Versioning is not necessary).

Order Enter a sequence number for the Schema. This sequence will
determine the order in which the schemas are versioned.

Database Enter the Schema's database.
Schema Enter the schema that you wish to version.
Password Enter Schema's password.

Enabled When checked, objects in Schema are versioned.
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Optional: Either of these SQL WHERE clauses:
name_of_object comparison

type_of _object comparison

For example:
name_of _object like "%ACCOUNT%"

If the condition generates an SQL error, Automated Versioning
will fail.

This field shows where the DDL scripts will be stored for each object.
You may modify this directory but the location must be writeable.
This field defaults to the Archive Location with the database and
schema name appended.

This button displays the Add Schemas window (p. 98).

List of known SQL object extensions.
Object's name.

When checked, this type of object is versioned.

Add Schemas

This window lets you add all of a database's schemas to the Schemas tab (p. 97). Select
a Database, and click Add Schemas.
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File Locations
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Include Subdir... Copyfrom ...

This tab lets you specify the directories that should be searched for changed and new
files. Automated Versioning finds files with the extension FMB, PLL, INP, RDF, or any
other extension defined in the File Types area. All values entered in this tab take effect

as soon as you click & (Action > Save).

Oracle E-Business Suite users: Enter only those directories that contain custom
modules. Automated Versioning will version all files in the specified directories,
regardless of whether the file is linked as an Oracle module in Maintain Versions'
Link Modules window (p. 54). This feature allows email messages to be sent
automatically to the Codebase Administrator when a new custom file is
introduced into your system.

If you have entered records in the Projects window's Promotions tab (p. 37), enter only
the file locations that correspond to an Initial Stage. The available List of Values
(Ctr1-L) will help you restrict your entries to only those directories that have
previously been entered for an Initial Stage Environment.

Fields

Order Enterasequence number for the File Locations. This sequence
will determine the order in which the locations are processed.

Host Unix/Linux only: Host used to access the File Locations.
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Enter valid directories that contain the files to be versioned. You
may enter the directories with or without a backslash (\) at the
end. Use the List of Values (CtrI-L) to obtain file locations that
have previously been entered in other components of the
Codebase Suite.

Locations specified in the Schemas tab's (p. 97) Output
Script Location field are automatically added to this list.
Checking or unchecking their Enabled boxes here does
not affect the way Automated Versioning processes
database schemas and objects - Automated Versioning
always generates DDL files for the database objects
specified on the Schemas tab, and places those files in the
Output Script Locations. This tab's Enabled checkboxes
merely determine whether those files will be versioned.

You cannot query records in this Tab. The entire record set
will always be displayed.

To refresh this information, you can click on Edit/Clear-
Form in the menu.

The directory must be readable or you will receive an error.

When checked, files in this location will be versioned.

Files with these extensions will be versioned.
$$$ or NONE refers to files without extensions.

To edit this list, use the Automated Generation window's
Extensions tab (p. 112).

Indicates whether the file contains plain text.

Indicates whether the file contains LCT content.
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Insert Subdir... Displays the Include Subdirectories window (p. 101).
(button)

Copy From... Displays the Copy Locations From... window (p. 101).
(button)

Include Subdirectories

ﬁ Include Sub Directories

Add Directories

To add File Locations rows for each subdirectory of a specified directory, choose the
appropriate Host, enter the full path to the parent directory in File Location, and click
Add Directories.

Copy Locations From

Cog cations Fram .

U TSATOW%

Select a location from the list and click OK. To filter the list, enter a value in the Find
field (use % as a wildcard) and click the Find button.
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Filters
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To force the processing of specific files, select their File Locations, enter their names
in the File fields, and set Include/Exclude as desired. You may use asterisks (*) as
wildcards in the File field.
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Automated Generation
ﬁ Mavigatar [Alan]
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Automated Generation performs code migration, installation and generation of
software. It generates forms, reports, and libraries after running SQL scripts against a
given database. It can also extract promoted files from the Automated Versioning
archives, if you use Automated Versioning (p. 93) for version control.

Automated Generation is also capable of creating executables for any development
tool (e.g., Powerbuilder, Visual Basic, etc.) by using the Extensions tab (p. 112) to
specify the command to execute for a given file type.

Automated Generation automatically regenerates forms that reference changed
forms.

When at least one schema is entered for an Environment, Automated Generation
recompiles all invalid objects.

To use Automated Generation:

As with all automated processes, you must have the Projects: Users tab's (p. 34)
Admin privilege to configure and schedule this process, and the tab's Jobs
privilege to view its execution status and logs.

In the Navigator window (p. 20), select your Project.

Double-click Project Navigation > Configurations > Automated Generation. The
Automated Generation window appears.
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3 At the top of the window, choose the destination Environment (i.e., the Environment
to migrate to).

4 Configure the window's tabs (General (p. 106), Reports (p. 108), Schemas (p. 109), File
Locations (p. 110), Filters (p. 111), Extensions (p. 112) and SQL Errors (p. 114)).

If you plan to use Automated Generation to migrate files, the directory structures in
the source and destination Environments must match.

If you plan to use Automated Generation to generate SQL scripts, the scripts:
Must not use the SPOOL command. Integra Codebase logs script results itself.

Must not use the EXIT command, or Integra Codebase could be prevented
from creating its log files.

Must not use the CONNECT command. All scripts must run against the
compilation schema defined for the Environment.

Must not prompt for input. For example, do not use & or &&.

Oracle E-Business Suite users: \We recommend that you configure Automated
Generation to process all custom schemas within an Environment prior to processing
the Automated PublishingPS schema, if itis present.

5 Click the General tab's (p. 95) Schedule button. The Schedule window (p. 141)
appears.

6 Set all scheduling options as desired; you can run Automated Generation once, or
repeatedly. For example, you can generate modules (i.e., files and database objects)
nightly.

If you are generating database objects, the source and destination Environments'
databases must be running in order for Automated Generation to function

properly.

Do not run more than one instance of Automated Generation at the same time.
Do not run Automated Generation concurrently with any process other than
Automated Versioning. (You may run Automated Generation and Automated
Versioning concurrently.)

7 Click the Schedule button. A new job is created; its activities can be monitored in the
View Inside Jobs window (p. 135) and its log (p. 139).

When errors occur, they will be written to the log (p. 139). The program can be
restarted at anytime after a problem or system crash has occurred. The program will
start processing where it left off.
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If Automated Generation fails to generate a file, it automatically attempts to
regenerate the file on the next run. Likewise, SQL scripts will also be rerun if errors
occurred on the previous run.

Integra Codebase assumes that reprocessing modules will not harm your
Environments. Your standards and Environments should reflect this assumption;
for example, do not allow developers to use DROP TABLE or DROP SEQUENCE
statements in any SQL scripts, so there’s never a risk of accidentally dropping a
table or sequence. (This is also true when using manual generation processes,
because of the possibility of human error.)

When Automated Generation finishes, it sends the message Automated Generation
Job Information to the recipients specified in the Projects window's Email setup tab (p.
39).

8 If you have scheduled repeated execution of Automated Generation, check the log (p.
139) periodically to ensure that no errors occur.
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This tab contains the following fields and buttons:

Generation Options

Last Version
Location

Temp Directory

Forms Version

This directory stores the last version of each module. It will be
defaulted to a directory created by Codebase on your Codebase
Server at the time the project was created.

Make sure there is plenty of disk space for one version of each
module. This directory must be different than the locations
specified elsewhere in Codebase.

The directory must exist, and be readable and writeable.

Full path on Codebase Server to directory where Codebase can
store files temporarily.

The Environment's Oracle Forms version (used to compile forms).
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Host Command Options

Run before

Run after

Schedule
(button)

This command is used to run a program before Automated
Generation runs. This command is useful for interfacing to other
programs and will wait until the called program finishes. Any valid
operating system command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

This command is used to run a program after Automated Generation
runs. This command is useful for interfacing to other programs and
will wait until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

Begins the process of scheduling Automated Generation. Displays the
Schedule window (p. 141).
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L=yl TEST -

Reports

® Enyironment

[ Compare o [TEST

O Audit

" Unpromoted Contert

Four reports are available on this tab:

Environment

Compare

to
(dropdown)

Audit

Unpromoted
Content

Submit
(button)

Shows modaules (i.e., files and database objects) processed by
Automated Generation on Environment.

Compares the modules processed by Automated Generation on
Environment to the environment specified in the to dropdown.

Shows differences between the version information stored in
Codebase and the actual Environment.

Shows modules in the Initial Stage Environment that were not
promoted to Environment.

Click this button to generate the selected report.
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Schemas
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This tab contains these fields:

Order Enter a sequence number for the Schema. This sequence will
determine the order in which the schemas are processed.

Database Select the Schema's database.
Schema Enter the schema that you wish to process.
Password Enter Schema's password.
Versioning The schema that Schema will be compared to. The schemas listed
Schema ¢ specified on Automated Versioning's Schemas tab (p. 97).
Tablespaces

Data Tablespace used to temporarily hold data while processing the
schema.

Index Index used to reference Data.

Enabled When checked, the Schema is processed.
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File Locations

ﬁ Automated Generation far PR
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This tab contains these fields:

Order Enter a sequence number for the File Locations. This sequence
will determine the order in which the locations are processed.

Host Unix/Linux only: Host used to access the File Locations.

File Locations Enter valid directories that contain the files to be versioned. You
may enter the directories with or without a backslash (\) at the
end. Use the List of Values to obtain file locations that have
previously been entered in other components of the Codebase
Suite.

You cannot query records in this tab. The entire record set
will always be displayed.

To refresh this information, you can click on Edit/Clear-
Form in the menu.

The directory must be readable or you will receive an error.

Compilation Schema to use when compiling forms (to resolve references to
Schema g5tabase objects).
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Version Location Location containing the files that File Locations will be
compared to.

Promote Only When checked, Automated Generation promotes the file(s)
without compiling them.

.
Filters
ﬁ Automated Generation far PROJECT

Filters

File Location File: Mame: IncludeExclude

[¥)

- -

| | | || | | || |-

To force the processing of specific files, select their File Locations, enter their names
in the File fields, and set Include/Exclude as desired. You may use asterisks (*) as
wildcards in the File field.
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This tab specifies the file extensions that Automated Generation will process, how
each extension will be processed, and the order in which they will be processed (e.g., a
table must exist before an index can be created).

Execution This field, in combination with Order, determines the order in which
Time  (he extensions are processed.

Extensions are processed in this order:
1.Beginning
2.SQL Script
3.After SQL Scripts

4. End

...and within each of those, by Order. Extensions with Execution
Time set to Never are not processed.

Order Enter a sequence number for Extension. This sequence, in
combination with Execution Time, determines the order in which
the extensions are processed.
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Extension Enter a filename extension.

For files without an extension, enter $$$ or NONE as the
extension.

Command Operating system command to run after promoting the file.
Typically used to compile the file's content (forms and SQL are
compiled automatically).

If the command fails, generation will not complete.

Executable If specified, Codebase will verify that a file with the versioned file's
Extension ,3me and the specified extension was created.

Log File If specified, Codebase will search for a file with the versioned file's
Extension ,3me and the specified extension, and if found, will add the file's
contents to the log (p. 139).

Text File If checked, Automated Publishing (p. 124) can document the file.
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SQL Errors
ﬁ Autamate
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This tab defines errors that should be detected in the SQL log files that are produced
when Automated Generation runs SQL scripts. The log files for each SQL script will be
placed in the same directory as the script itself.

Upon installation, default records will be created for some commonly occurring errors
(as shown above). The errors that you define in this tab will depend on your standards
and how SQL scripts are written. Because organizations handle error checking
differently, additional errors/warnings can be added to this screen. Viewing the SQL
error summary file could reveal errors that you might want to add.

Until you are familiar with the Automated Generation process, do not remove
any of the default records that appear on this tab.

Each SQL log file will be searched line by line for the error strings entered in this
screen. The search is not case-sensitive. Enter one error per line; the percent symbol (%)
is a wildcard representing zero or more characters.

If any Detect error strings that do not match any Ignore or Warning error strings are
found, the SQL script execution is considered a failure; thus, the SQL script will be
rerun the next time that Automated Generation runs. If all Detect error strings match
Warning or Ignore error strings, and at least one matches a Warning error string, the
SQL script execution is considered successful and a notification is sent (see Projects:
Email setup (p. 39)). If all Detect error strings match an Ignore error string, the SQL
script execution is also considered successful.
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Regardless of the number of matching error strings for a Warning that are found,
a notification will not be sent unless one of the Warning error strings also
matches a Detect error string.

The tab contains these fields:

Detect Determines whether to detect an error, ignore an error, or define a
warning to be detected when SQL scripts are run. This is a dropdown
list where you can choose Detect, Ignore, or Warning. For
example, you may want to detect all ORA-% errors but choose to
make all ORA-00955 errors a warning. When a warning occurs, all
processing continues as normal with the exception of the notification
being sent.

If you want to define a Warning error string, the same error string
must match a Detect error string. If the Warning error string does
not match a Detect error string, the string will be ignored (see
above). Detecting ORA-% as an error is considered to include the
warning ORA-00955% because of the wildcard (%).

Possible Enter the error text to search for when Automated Generation runs
SQL Errors 5| scripts.
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Automated Change Finder
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Automated Change Finder automates the process of creating difference reports for
forms (FMB and INP), reports, libraries, text files, and database schemas. To keep this
information up-to-date, we recommend that you run this process nightly.

Automated Change Finder, like Automated Publishing, processes files with any
extension listed on the Automated Generation window's Extensions tab (p. 112).

Before you can use Automated Change Finder, you must add all schemas to be
monitored for changes (on the Schemas tab (p. 120)), and add the locations of the
form, report, library, and other files to be monitored (on the Directories tab (p. 121)).

To monitor files in more than one Environment (e.g., development, test, and
production), create a project for each. You can, however, monitor your development,
test, and production database schemas from within the same project.

If a subclassed form is modified, and is being used in another form, the latter
form will be compared to its previous version. Thus, the modification to the
subclassed form will appear in the difference report (assuming the modified
object was being referenced).



Projectsrole 117

To use Automated Change Finder:

As with all automated processes, you must have the Projects: Users tab's (p. 34)
Admin privilege to configure and schedule this process, and the tab's Jobs
privilege to view its execution status and logs.

1 Inthe Navigator window (p. 20), select your Project.
2 Double-click Project Navigation > Configurations > Automated Change Finder.

3 Configure the window's tabs (General (p. 118), Schemas (p. 120) and Directories (p.
121)).

4 C(lick the General tab's (p. 118) Schedule button. The Schedule window (p. 141)
appears.

5 Set all scheduling options as desired; you can run Automated Change Finder once, or
repeatedly. For example, you can publish documentation nightly to provide
developers with up-to-date information.

Never run more than one instance of Automated Change Finder at the same
time, unless the process is for separate projects. Do not run Automated Change
Finder and Change Finder concurrently.

6 Click the Schedule button. A new job is created; its activities can be monitored in the
View Inside Jobs window (p. 135) and its log (p. 139).

When errors occur, they will be written to the log (p. 139). The program can be
restarted at anytime after a problem or system crash has occurred. The program will
start processing where it left off.

7 After verifying that Automated Change Finder has run successfully, you can view the
results by clicking the General tab's View Changes button (p. 78).

8 If you have scheduled repeated execution of Automated Change Finder, check the log
(p. 139) periodically to ensure that no errors occur.

To compare directory contents:

It is possible to compare two directories, but you'll need to create another project so
you don't erase existing Automated Change Finder data. After creating another
project, follow the instructions below to perform a comparison of multiple directory
structures:

1 Enter all directory structures in the Directories tab (p. 121) for the new project.
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2 Run Automated Change Finder to establish a baseline.

3 Either change the directories that were entered in Step 1, or remap your network drive
to point to the new directory structures.

4 Rerun the Automated Change Finder to capture all the changes.

5 Click the General tab's (p. 118) View Changes button to review the differences.

General
Ef Automated Change Finder for PROJEGT] (i eieibeeieie e e e e e e e e e el e 36
General Schemas | Directories

iv (O] ) ationic )|

Host Command Options

Run Before |

Run after |

Summary Report
View Changes
Schedule

This tab contains the following fields and buttons:

Forms The version of Oracle Forms installed in the project's Environments.
Version

Temp Dir Full path on the Codebase Server to a directory where Codebase can
temporarily store files.



Projectsrole 119

Host Command Options

Run before This command is used to run a program before Automated Change
Finder runs. This command is useful for interfacing to other programs
and will wait until the called program finishes. Any valid operating
system command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

Run after This command is used to run a program after Automated Change
Finder runs. This command is useful for interfacing to other programs
and will wait until the called program finishes. Any valid operating
system command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

Summary Displays a report of all differences found.
Report
(button)

View Displays the View Changes window (p. 78).
Changes
(button)

Schedule Begins the process of scheduling Automated Change Finder. Displays
(button) the Schedule window (p. 141).
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View Changes
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This tab lets you specify the schemas that should be monitored for changes.

The INIT.ORA file for the database where Codebase resides must have
global names set to FALSE.
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The tab contains these fields:

Database Database that holds the Changed Schema.

Changed Schema to monitor.
Schema

Password Changed Schema's password.

Original Schema that Changed Schema will be compared to.
Schema

Original File Full path to the directory that holds the SQL scripts and packages
Location (q|ated to Original Schema.

Enabled When checked, this schema will be monitored.

Directories

General Schemas | Directaries

Order Include Subdirs
| Changed Host Changed Location Original Hozst Qrrigingl Location Enabled
l ] | subsco | iapplimation/coc42_compile | subsco | iapplimstion/coc42_compile_t

»

ﬁ
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This tab lets you specify the directories that should be searched for files with
extensions specified in the Automated Generation window's Extensions tab (p. 112).
All values entered in this tab will take effect immediately, without requiring a restart of
the Automated Change Finder.

Be sure to include any directory that may contain referenced forms or attached
libraries. An error will occur whenever a referenced form or attached library
cannot be found in the directories you've specified.
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Also, be sure to specify the file locations for all Oracle Modules that you have
linked your Custom Module against. One commonly overlooked directory is the
FND directory that contains the TEMPLATE . fmb file.

If a referenced form is modified, and is being used in another form, the latter will
automatically be compared to its previous version. Thus, the modification to the
referenced form will appear in the difference report (assuming the modified
object was being referenced).

Order

Changed Host

Changed Location

Include Subdirs

Original Host

Original Location

Automated Change Finder will process the locations in this
order. The order becomes important when a duplicate file is
found in multiple directories. The first occurrence of a
duplicate file is processed and all other occurrences are
skipped.

Host used to access Changed Location.

Enter valid directories that contain the form, library, report,
and text files. You may enter the directories with or without
a “\" at the end. These same file locations should exist in the
FORMS60_PATH environment variable.

You cannot query records in this tab. The entire record
set will always be displayed.

To refresh this information, you can select Edit > Clear
> Form from the menu bar.

If the directory is not readable, you will receive an
error.

Check this box to include all subdirectories of the location. If
the same file exists in more than one subdirectory, the first
occurrence of the file will be used.

Host used to access Original Location.

Directory that holds files to be compared to those in
Changed Location.
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Enabled When checked, the files in Changed Location are
processed.
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Automated Publishing
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Automated Publishing produces documentation of your forms, reports, menus,
libraries, and SQL code. You can use these reports for code reviews, exception
reporting, documentation, disaster recovery and impact analysis. They are also used
by Object Finder's Subclassed Forms (p. 88) and Attached Libraries (p. 90) tabs.

Automated Publishing processes files with the following extensions:

FMB, MMB, OLB, RDF, PLL

Any extension specified in the Automated Generation window's Extensions tab
(p. 112) with the Text File checkbox selected

If you want to use Automated Publishing to monitor several Environments, such as
development, test and production, create a separate project for each.

When publishing a form, Automated Publishing does not publish the libraries
attached to the form.

If a referenced form is modified and is being used in another form, the latter form
will automatically be re-published to show changes made on the referenced
object(s). Thus, the modification to the referenced form will appear in the Form
Document report (assuming the modified object was being referenced).

If you set up Automated Publishing to process only Automated Change Finder’s
Last Version Location directory, run Automated Change Finder before running
Automated Publishing.
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To use Automated Publishing:

As with all automated processes, you must have the Projects: Users tab's (p. 34)
Admin privilege to configure and schedule this process, and the tab's Jobs
privilege to view its execution status and logs.

In the Navigator window (p. 20), select your Project.
Double-click Project Navigation > Configurations > Automated Publishing.

Configure the window's tabs (General (p. 126), File Locations (p. 130), Properties (p.
132) and Filters (p. 133)).

Click the General tab's (p. 126) Schedule button. The Schedule window (p. 141)
appears.

Set all scheduling options as desired; you can run Automated Publishing once, or
repeatedly. For example, you can publish documentation nightly to provide
developers with up-to-date information.

Never run more than one instance of Automated Publishing at the same time,
unless the instances are for separate projects. Automated Publishing can run
concurrently with any other process, except Change Finder.

Click the Schedule button. A new job is created; its activities can be monitored in the
View Inside Jobs window (p. 135) and its log (p. 139).

During its initial run, Automated Publishing creates a report for every source file it
processes. This process may be time-consuming, depending upon the project's size.
Most subsequent runs require significantly less time, because Automated Publishing
processes only the files that have changed since its last run.

When errors occur, they will be written to the log (p. 139). The program can be
restarted at anytime after a problem or system crash has occurred. The program will
start processing where it left off.

After verifying that Automated Publishing has run successfully, view the results by
clicking the General tab's View Reports button (p. 129).

File Date depends on whether Automated Change Finder has processed the file.
If it has, File Date is the file's modification date at the time Automated Change
Finder processed it. If it has not, File Date is the file's modification date at the
time Automated Publishing processed it.
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Also, you can now use Object Finder's Subclassed Forms (p. 88) and Attached Libraries

(p. 90) tabs.

8 If you have scheduled repeated execution of Automated Publishing, check the log (p.

139) periodically to ensure that no errors occur.

General

General File Lacations FProperies Filters
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Host Command Options

Run before jok |

Run after job |

View Reports
Schedule

This tab lets you configure Automated Publishing (p. 124).

If a form is modified and its objects are being subclassed in another form, the latter
form will automatically be republished to show changes made to the subclassed
object(s). Thus, the modification to the subclassed objects will appear in the

documentation generated by Automated Publishing.

The values entered in this tab will not take effect until Automated Publishing is

restarted.

This tab contains the following fields and buttons:

Publishing Options

Output Enter a directory where the reports should be stored. All developers
Location st have access to this directory so that they can view the reports
via the View Reports screen. The directory must exist and be
readable and writeable, otherwise you will receive an error

message.

Forms Version The environment's version of Oracle Forms.
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Compare File
Datetime Only

Compare File
Datetime and
Contents
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Select this radio button when you want files to be considered
changed based solely on the system file date. The system file date
will be compared to the file date stored internally by Automated
Publishing. If the file dates are different, then Automated Publishing
will consider the file to be changed. This option will optimize the
amount of disk space that is required to run the Automated
Publishing.

There are cases when a file's date will change but its contents
remain the same. One such scenario is when a file gets
checked out of a traditional version control system with a new
timestamp. Another scenario occurs on some Microsoft
Windows platforms when the Automatically Adjust for
Daylight Savings option is turned on causing all files being
viewed through the Windows software to change by one hour.
If either of these scenarios occur, several modules may be
analyzed needlessly. This problem could cause extensive
processing to occur. These scenarios are correctable, but if you
find a scenario in your environments that cannot be easily
corrected, use the Compare File Datetime and Contents
option.

Select this radio button when you want content to be considered
changed based on both the system file date and the file's contents.
The system file date will be compared to the file date stored
internally by Automated Publishing. If the file dates are different,
the contents of the file will be compared to a version that was
previously saved by Automated Publishing (see Last Version
Location). When the file date and contents both change, the
module will be re-published. This option requires more disk space,
to store an additional version of each file. This option will optimize
the performance of Automated Publishing.
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Last Version This directory will be defaulted to a directory created by Codebase
Location o, your Codebase Server at the time the project was created. This

directory stores the last version of each module. Make sure there is
plenty of disk space for one version of each file. This directory must
be a different location than the ones specified in other Codebase
windows.

If you decide to change the value, the directory must exist, be
readable and writeable. Otherwise you will receive an error
message.

Host Command Options

Run before This command is used to run a program before Automated Publishing

Run after

runs. This command is useful for interfacing to other programs and
will wait until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).

This command is used to run a program after Automated Publishing
runs. This command is useful for interfacing to other programs and
will wait until the called program finishes. Any valid operating system
command can be entered here.

The sub_the_user_login runtime variable is available to obtain the
login username, password, and database connection string.

The sub_env_passwd_???$ runtime variable is available for
obtaining the password to a Versioning Schema in Automated
Generation (see Schemas (p. 109) for more information).
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View Displays the View Reports window (p. 129).

Reports
(button)

Schedule Begins the process of scheduling Automated Publishing. Displays the
(button)  schedule window (p. 141).

View Reports

ﬁ Wiew Publishing Documents

L mationidevianother txdj
A0 fapplimationsdeyfsubscOltest td

This window lists all modules (i.e., files and database objects) documented by
Automated Publishing (in the currently selected project). To view a document, click
the Actual File, and then click View.
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File Locations
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This tab allows you to specify the directories that should be searched for files with an
extension of:

FMB, PLL, RDF

Any extension defined in the Automated Generation window's Extensions tab
(p. 112) that has Text File checked.

All values entered in this tab will take effect immediately (restarting Automated
Publishing is not necessary). To refresh the information in this tab, select Edit > Clear
Form from the menu bar.

Automated Publishing will save all form and library dependency information for
the FMB and PLL files contained within the directories in this tab. Be sure to
include any directory containing files that you want to view via the Object
Finder screen.

Unlike the Automated Change Finder, Automated Publishing does not look at
the links you have created in the Link Modules window (p. 54). Thus, each and
every form, report, library, and text file that is found in the directories you specify
will be processed (including the Oracle vanilla files). This is different than the
Automated Change Finder, since the Automated Change Finder only processes
linked files when Processing Options is set to Process Only Linked
Modules.
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When entering directories, be sure to include any directory that may contain a
subclassed form. Otherwise, an error will occur when subclassed forms cannot be
found in the directories you specified. When publishing a form, libraries attached
to the form will not be published along with the form because the

Oracle E-Business Suite users: You may need to specify Oracle's standard forms'
directories, so subclassed forms can be found for your custom forms. If you do not

want to publish all of Oracle’s standard forms, use the Exclusions tab to exclude them.

The tab contains these fields:

Order

Host

File
Locations

Include
Subdirs

Enter a sequence number for the File Locations. This sequence will
determine the order in which the locations are processed.

Unix/Linux users: Select the Host used to access File Locations.

Enter valid directories that contain the form, library, report, and text
files. You may enter the directories with or without a “\" at the end.
These same file locations should exist in the FORMS60_PATH
environment variable or some Oracle tools will not work properly
(see Oracle installation manual) when searching for referenced forms
and attached libraries. The directory must be readable or you will
receive an error.

Check this box to include all subdirectories for the entered file
location. This will eliminate ongoing maintenance when directories
get added under the parent directory.
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Properties
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’— [ | | Alerts Faoreground Calor
(] W [woTnuLL Alerts Message -

This tab lets you specify the properties that will appear in the documents created by
Automated Publishing. These settings apply to Forms, Reports, Object Libraries, and
PL/SQL Libraries. The settings will also be used when manually creating a document
using the Change Finder. A document will also be created by comparing a file and
directory location to itself in the Change Finder; likewise for reports, libraries, and text
files.

Show Check this box to document the property.

Only when Adding a value in this field will further restrict the occasions when the
valueis... roperty is documented. Entering NULL will document the property
only when it has no value. Entering NOT NULL will document the
property when it does have a value. Specific values can also be
entered, such as True, False, 1, 0, etc. When ! is the first character, it
is a NOT operator (e.g., 10 means "not a value of zero," 1False means
"not a value of False," etc.). Use % as a wildcard.

This field has no effect for the Object Type A Subclassed Object.

Object Type Displays the type of Forms/Reports Designer object that the property
belongs to (e.g.,, Data Blocks, Triggers, Summary Columns,
Frames, etc).

Property Displays the Property Name that appears in the Forms/Reports
Name pesigner.
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Filters

@ Automated Publishing for PROJECT1

Filters

File Location File: Mame: Include/Exclude

I

-

CJC JCJC JC 0 JC JC JC JC JC_JC_JC_JC_IC_JC_Je

]

To force the processing of specific files, select their File Locations, enter their names
in the File fields, and set Include/Exclude as desired. You may use asterisks (*) as
wildcards in the File field.
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Jobs

| PROJECTH -

C-ofs Project Havigation
1 Workbenches
%l‘l‘_ Automation
g iobs)

L\/ View Inside Jobs

Many Codebase actions take place in the background, leaving you free to move on to
other tasks. These background actions are called Jobs.

In This Section
View Inside Jobs 135
Schedule 141




Jobs 135

View Inside Jobs

(T

~ || Advanced Search

[ 230 m LA A tomsted Generation Job completed successully. 0122007 1437 01 M 202007 1437130011 2/2007 14:37:45]32 seconds
| 229 229 LA Automated Versioning Job completed successtully. 0141002007 2332 01102007 23:32:34)01 M 0/2007 23:49:01 |16 minutes 27 seconds
| 228 Atomated Publishing Job completed successully. 011002007 2327 01 002007 23271101 M 0/2007 232751 |40 seconds
|2 Automated Generation Automated Generation has warf( /1072007 23:08 |01/10/2007 23:08:309|01/10/2007 2308 445 seconds
228 Automated Yersioning Job completed successfully 01 A0/2007 2307 |01 4052007 23:08:00(014 0/2007 2308 044 seconds
| 225 Automated Versioning Job completed successtully. 01102007 23:06 011052007 23:06: 23001 M 0/2007 23:06: 34111 seconds
224 Automated Change Finder  |Job completed successfully 01 A052007 2302 |01 4052007 23:02:48/014 0/2007 2302 48|53 seconds
223 Automsted Publishing Joh completed successully. M A002007 22239 011062007 22:39:54)01 1072007 22:40:52]38 seconds
222 Automated Publishing Job completed successfully 01 052007 22468 |01 A 052007 22:16:56/0140/2007 22171317 seconds:
221 Automsted Publishing Joh completed successully. M A02007 1653 J01 1062007 15:53:52001 1072007 18:54.10|18 seconds
220 Automated Generation Automated Generstion has warr0 /1072007 16:39 |0110,2007 16:59:48)0110/2007 17:00:04/16 seconds
219 Automsted Generation Joh completed successully. 1002007 16:54 011042007 16:54:00001 1072007 16:54. 26]17 seconds
218 Automatedd Generation Failure occurred during Automation 102007 1525 J01 1 002007 152519001 M 0/2007 15:25:36)17 seconds
217 Automatedd Generation Failure occurred during Automatio A 002007 1344 011002007 13:44:42001M0/2007 13:44:59017 seconds
> 216 Automated Generation Automated Generstion has warr0 /1072007 1333 01102007 13:33:46)0110/2007 13:34:04]16 seconds
View Log Terminate Resume v Rpt Refresh

Integra Codebase schedule jobs to perform most of its actions. This window lets you
monitor, control and schedule jobs.

To display the window, double-click Jobs > View Inside Jobs in the Navigator window
(p. 20).

The Quick Find dropdown lets you display:
All My... All...

Jobs Jobs

Jobs Submitted Today Pending Jobs
Pending Jobs Running Jobs
Running Jobs Scheduled Jobs
Scheduled Jobs Cancelled Jobs
Cancelled Jobs Failed Jobs
Failed Jobs Warning Jobs
Warning Jobs

The Advanced Search button lets you search for:

All Jobs View jobs created by all users, just yourself, or another
My Jobs | cer.
Jobs with Specific Owner

Program View jobs containing the specified program.

Started On View jobs begun on the specified date.



Completed On
Submitted On

Scheduled On

Sort:
Ascending
Descending

None
Program Name
Started On
Completed On
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View jobs finished on the specified date.
View jobs submitted on the specified date.

View jobs that are scheduled to start on the specified
date.

Sort jobs in the specified order, on the specified
column.

The window also contains these fields and buttons:

Quick Find (Described above)

Advanced Displays the Advanced Search window (p. 137).

Search
(button)

JobID Each jobis assigned a number when it is submitted.

Task ID Each job is also assigned a task number when submitted.

User The Codebase user who submitted the job.

Description The first program to be executed.

Status The job's current execution status. The Warning status indicates
that important messages can be found in the job's log (p. 139). To
view the log, click the View Log button.

Date The date and time when the job was submitted.

Submitted

Started The date and time when job execution began.

Completed The date and time when job execution ended.

Elapsed The difference between Completed and Started.



View Log
(button)

Terminate
(button)

Resume
(button)

Schedule...
(button)

Summary Rpt
(button)

Auto Refresh

Refresh
(button)
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Displays the Log window (p. 139).

Ends execution of the selected job as soon as possible.

Continues the execution of a paused job.

Displays the Schedule window (p. 141).

Displays a report that summarizes the activity in the selected job.

When checked, the job data in this window is refreshed
periodically.

When clicked, the job data in this window is refreshed.

Advanced Search

Search Criteria

Program

The window contains these fields and buttons:

Filter

All Jobs
My Jobs

Jobs with
Specific Owner

Program

Started On

Select whose jobs you want to find.

Find jobs containing the selected program.

Find jobs started on this date.



Completed On
Submitted On

Scheduled On

Sort

Ascending
Descending
None
Program Name
Started On

Completed On

Clear (button)

OK (button)

Jobs

Find jobs completed on this date.
Find jobs submitted on this date.

Find jobs scheduled to begin on this date.

Choose sort direction.

Choose the field to sort on.

Resets the window's fields to their default values.

Performs the search.

138
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06-12-2006 16:54:06: PLL dependent check completed.

06-12-2006 16:54:06: Promoting source...

06-12-2006 16:54:07: Looking for versions to promote to DEY - L02fapplimation ey
0E-12-2006 16:54:07: Deploying MO2iEpplimationfdewresetion t to A02fappimationsde,
06-12-2006 16:54:07: wersion promation completed.

0E-12-2006 16:54:07: Step!: CBGenerationBO: Getting Promation Cirectories ..
06-12-2006 16:54:07: Stepz: CBGenerationBO; Getting Directory Schema Info...

06-12-2006 16:54:07: Stepd CBGenerationBO: Getting Directory Host Info...
06-12-2006 16:54:07: Stepd: CBGenerationBO; Getting Directory Config Info...
06-12-2006 16:54:07: Looking for wersions to generate on D2fsEpplimationddey - DEY
06-12-2006 16:54:07: Steps: CBGenerationBO: Getting List of Madules (Files) to generate ...
06-12-2006 16:54:07: Steph: CBGenerationBO: Getting ModulesFile info ...
06-12-2006 16:54.07: StepT: CBGenerationBO: executing compie far null...
06-12-2006 16:54:08: Generating : resetiog bxt to M02fspplimstionides

06-12-2006 16:54:08: Stepd: CBGenerationBO; setting aeneration of nullto Complete
05-12-2006 16:54:08; ***** Processed 1 Modules/Files sttt

06-12-2006 16:54:08; **** Processed 1 Directorigs =

0E-12-2006 16:54:08: “ersion generation completed.

The View Inside Jobs window's (p. 135) View Logs button displays this window, which
contains the execution log of the selected job.

Errors are listed in the log. They typically appear when:

FORMS60_PATH (or FORMS90_PATH) does not contain the proper directory
locations for referenced files

Files are corrupted

Be sure to periodically check the log to ensure that no errors have occurred.
The window contains these fields and buttons:

View Lines To filter the lines listed, change the View Lines dropdown, fill

. in any fields that appear, and click View.
View (button)

Wigwe Lines

First (button) Displays and selects the log's first row.



Previous (button)

Next (button)

Last (button)

Auto Refresh

Refresh (button)

Print (button)
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Displays and select the row before the one that is currently
selected.

Displays and select the row after the one that is currently
selected.

Displays and selects the log's last row.

When checked, the log is refreshed periodically. Useful when
monitoring the progress of a job.

Refreshes the log. Useful when monitoring the progress of a
job.

Displays a printer-friendly version of the log.



Schedule

Eschedule -
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Add ltem ...

B Terminsted B Error Email _
e | loar | s

The window contains these fields and buttons:

Start

Immediate
On

Items to Execute

Items to
Execute

Add item...
(button)

Repeat

None
(run once)

Hourly
Daily
Weekly

Monthly

Choose to start the job immediately or on a certain date and time.

List of items that will be executed.

Displays the Add Item window (p. 143).

Specify how often job should be re-run.



..until

No End Date

End After _
Occurrences

End By

Notify when

Complete

Terminated

Error

Email

Clear
(button)

Schedule
(button)
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If job will repeat, specify when the repetition will end.

Sends a notification to Email when the job has completed
successfully.

Sends a notification to Email when the job has been terminated
by a user.

Sends a notification to Email when the job has ended in error.

Recipients of Completed, Terminated and Error notifications.
Separate multiple addresses with commas (,).

Resets all fields to their default values.

Submits the job.
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Add Item

ﬁ ltems to Execute

ltems to Execute

Farameter
Project I0 = Monday

This window contains these fields and buttons:

Program List of items that will be executed.
Parameter List of execution parameters for the selected Program.
Add (button) Displays the Add Program window (p. 144).
Delete Removes the selected Program from the list.

Done Saves your changes and returns you to the Schedule window (p.
141).
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Add Program

Bl add Frogram

Program
WEEN Automated Change Finder -
i Automated Change Finder

Parameter(s)

Project ID
Change Finder Mode
Definition

Mandatory Parameter(s)

This window contains these fields and buttons:

Program
Name Item that will be executed.

Description Description of item that will be executed.

Parameters

The fields in this section vary, depending on the Program.

Save (button) Saves your changes and returns you to the Add Item window (p.
143).

Cancel (button) Discards your changes and returns you to the Add Item window
(p. 143).
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Help

Selecting Help from the menu bar displays the following options:

Help Displays a list of common keyboard shortcuts.

Display Error Displays a list of recent error messages.

View Inside Jobs Displays the View Inside Jobs window (p. 135).

Show Navigator Displays the Navigator window (p. 20).

Window Help Displays help about the window currently in the foreground.

Equivalent to clicking ]
Integra Support Displays Oracle Support's home page.

About... Displays copyright information and version numbers.



